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About this Manual

About this Manual

Marks and Symbols

Caution:
Instructions that must be followed carefully to avoid bodily injury.

n Important:
Instructions that must be observed to avoid damage to your equipment.

Note:
Instructions containing useful tips and restrictions on printer operation.

£ Related Information
Clicking this icon takes you to related information.

Artwork

Screenshots used in this manual are currently under development. They may differ from the release version.

Operating System References

In this manual, terms such as "Windows 10", "Windows 8.1", "Windows 8", "Windows 7", "Windows Vista", "Windows
Server 2016", "Windows Server 2012 R2", "Windows Server 2012","Windows Server 2008 R2", and "Windows Server
2008" refer to the following operating systems. Additionally, "Windows"refers to all versions.

Microsoft® Windows® 10 operating system

Microsoft® Windows® 8.1 operating system

Microsoft® Windows® 8 operating system

Microsoft® Windows® 7 operating system

Microsoft® Windows Vista® operating system

Microsoft® Windows Server® 2016 operating system

Microsoft® Windows Server® 2012 R2 operating system

Microsoft® Windows Server® 2012 operating system

Microsoft® Windows Server® 2008 R2 operating system

0 0o 0o U o0 U o o o o

Microsoft® Windows Server® 2008 operating system
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Epson Device Admin Features

Main Features

Epson Device Admin is an application that allows you to install devices on the network, and then configure and
manage the devices. The following outlines the main features.

Epson Device Admin = 0 x
Home View Groups > @
Q = ] E3Add | Unde 3
i % £} LRSSt SCIN
All Selected Auto-Update Device Embedded Web | Apply Configuration Save as Configuration ~ Print Status  Discovery Firmware | Options
Devices Devices Configuration Server Template Template Sheet(s) .
Update Device Information Configuration Status Sheet Device List Option:
4 T Default Groups Search Filter 4 General -
i All Devices (10) Madel MAC Address P Address [status Last Updz Manufacturer EPSON
B New Devices (0) i Series 192.168.0.200 © Error 17287201t Mode! Series
i Configured Devices (0) 192168052 Idle status 1/28/201¢ DNS Name
B Ungrouped Devices (5) - Series 192.168.0.55 3 Ink: Follow the m... 1/28/201¢ MAC Address
£ Warning Devices (2) 192,168,054 e status — 1P Address 192.168.0.60
B Error Devices (3) Gt 102.168.0.60 Idle status 1/28/201¢ Serial Number TWE9101042
B Unresponsive Devices (0) 192.168.0.57 € Ink: Follow the m... 1/28/201t Last Update 1/28/2016 B:14:22 AM
4 [ User Defined Groups ) Series 192.168.0.56 ! Ink low. (Magent... 1/28/201¢ Last Update (UTC) 1/28/2016 4:14:22 PM
4 [ Paris office (2) (3) 192.168.0.58 Idle status 172872010 Memery 128
B Sales div. (3) Series 102.168.0.252 U Inklow. (Cyan)  1/28/201t Rear Paper Feed Installed
Series 192.168.0.100 Idle status 1/28/201¢ FAX Installed
Registered Date 1/28/2016 8:14:16 AM
4 Firmware
Version SELFOTFS
4 Status
Status Code 0004
Status Idle status
Status Last Updated  1/28/2016 8:14:25 AM
4 Supplies Last Updated
Supplies Last Updated  1/28/2016 8:14:25 AM
4 Cyan Ink
Level | [
. Model Number Cyan Ink Cartridge 165
= Devices 4 Magenta Ink
A ders Level |
- Model Number Magenta Ink Cartridge
é Reports 4 Yellow Ink
) . » Level | |
BB configuration Total: 10 - Error: 3 - Warning: 2 - Unresponsive: 0 - Unknown: 0 - Ready: 5 1/ 10 Madel Number Vellow Ink Cartridas 167
chy Intrenct access

4 Discovering devices

You can discovering devices on the network, and then register them to alist. If Epson devices such as printers and
scanners are connected to the same network segment as the administrator's computer, you can find them even if

they have not been assigned an IP address.

You can also discover devices that are connected to computers on the network by USB cables. You need to install

the Epson Device USB Agent on the computer.

Setting devices

You can make a template containing setting items such as the network interface and the paper source, and apply it
to other devices as shared settings. When it is connected to the network, you can assign an IP address on a device

that has not been assigned an IP address.

Monitoring devices

You can regularly acquire the status and detailed information for devices on the network. You can also monitor
devices that are connected to computers on the network by USB cables and devices from other companies that
have been registered to the device list. To monitor devices connected by USB cables, you need to install the Epson

Device USB Agent.
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4 Managing alerts
You can monitor alerts about the status of devices and consumables. The system automatically sends notification
emails to the administrator based on set conditions.

(1 Managing reports
You can create regular reports as the system accumulates data on device usage and consumables. You can then
save these created reports and send them by email.

Configuring the System

You can manage devices by setting up the following system.

Epson Device Admin
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4 Epson Device Admin system
This is a station where a computer for an IT administrator is installed so that devices can be managed.
Computers for an IT administrator
d Device Admin Client
This software should be installed on the computer for the IT administrator.
(d Device Admin Agent
This is installed along with this software, and then operates a service as part of a system. The regularly

acquires information, prepares reports, and sends alert notifications. The Device Admin Agent Monitor
monitors whether or not the Device Admin Agent operates correctly.
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(d EDA database

This is installed in this software and records all information.

Languages

Epson Device Admin supports the following languages.

English, French, Italian, Germany, Spanish, Chinese (traditional), Russian, Portuguese (Brazilian), Chinese
(Simplified), Portuguese (Portuguese), Dutch, Korean, Japanese
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Setting Up

System Requirements

The following requirements are necessary to install this software.

Hardware

Minimum system requirements

[ CPU: 2.0 GHz or faster x86/x64 processor

1  Memory: 4 GB or more

(d Hard disk: 500 MB or more free space (except Database usage)

4 Display:1024 x 768 or higher monitor resolution, High Color 32 bit

Recommended system requirements

[ CPU: 2.8 GHz or faster x64 processor (server system)

1 Memory: 8 GB or more

d Hard disk: 500 MB or more free space (except Database usage)
4

Display:1920 x 1080 or higher monitor resolution, High Color 32 bit

Software

Recommended Software

[ Runtime: .NET Framework 4.0 or .NET Framework 4.5

Note:
NET Framework 4.5 is installed as standard on Windows 8 and Windows Server 2012 or later.

(4 Internet Explorer 8 or later

This is necessary when displaying an archive report.

Ports to use

Epson Device Admin continuously listens to several ports, therefore those ports must be opened for specific features.
The following are the ports used by Epson Device Admin.
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Port Number Usage

161 Use this to acquire information on devices (SNMP).

3289 Use this to discover and configure devices on the network (ENPC).

427 Use this to discover devices on the network (SLP).

443 Use this to communicate by HTTPS, auto update, and update firmware.

25 (default)

Use this for the SMTP server that sends email. Change the port number depending on the
server.

587 (default)

Use this to send email using extended SMTP for security.

110

Use this to send email using POP before SMTP.

10015 (default)

Use this to request interfaces that communicate between services and this software.

8080 (default)

Use this to configure the proxy server settings and access the Internet.

64122

Use this to discover and configure USB devices by communicating with the Epson Device USB
Agent.

Windows services

This software registers the following as Windows services when setting up.

4 Epson Device Admin Agent

4 Epson Device Admin Agent Monitor

Virtual environment

This software will also operate under the following virtual environments. However, performance may decline
depending on the environment.

d  Hyper-V

d  VMWare vSphere

Notes on operation

Disable your computer's sleep function, otherwise this software will not operate correctly.

This software only supports IPv4.

0
4 Ifyou change the time zone setting while this software is operating, it will be applied after restarting.
0
0

We recommend using servers for 24 hour operation.
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Installing and Configuring the Environment

Preparing to install

.Net Framework

You need to install .NET Framework 4.0 or NET Framework 4.5 on the computer before you install this software.
However, on computers running Windows 8 or Windows Server 2012 or later, you do not need to install it since NET
Framework 4.5 is installed as standard.

See the Microsoft Website for information on downloading .NET framework, installing, and explanations on usage.

https://www.microsoft.com/en-us/download/details.aspx?id=17851

Epson Device USB Agent

When you want to manage devices that are connected to computers on the network by USB cables, install the Epson
Device USB Agent on the computer.

See the manual for the Epson Device USB Agent for details on installing and using the software.

Note:
From the install files for Epson Device USB Agent, the file for Epson Device USB Agent settings
(EDUSBAgentConfiguration.exe) is not used in Epson Device Admin.

Installing for the first time and changing features

Important:
Login to the computer by using an administrator account.

Initial installation

Follow the steps below to install this software.

Run Setup.exe.

The Setup wizard starts.

Note:
If the user account control screen is displayed, click Yes to allow installation.

10


https://www.microsoft.com/en-us/download/details.aspx?id=17851

Epson Device Admin User Guide Win

Setting Up
Click Next.
Epson Device Admin - InstallShield Wizard *
Welcome to the InstallShield Wizard for Epson Device
The Installshield Wizard will install Epson Device Admin on your computer.
To continue, dick Next.,
>

WARNING: This computer program is protected by copyright law and international
treaties.

Unauthorized duplication or distribution of this program, or any portion of it, may resultin
severe dvil or criminal penalties, and will be prosecuted to the maximum extent possible
under the law.

< Back |Next> Cancel

3 Check the licensing clauses, select I accept the terms of the license agreement, and then click Next.

Epson Device Admin - InstallShield Wizard *
License Agreement
Flease read the following license agreement carefully.
>

SEIKO EPSON CORPORATION ~

SOFTWARE LICENSE AGREENENT

IMPORTANT! RELD THIS SOFTWARE LICENSE AGREEMENT CAREFULLY.
The computer software product, fontware, typefaces and/or

S U SO, EOS AL S,

[@ 1 accept the terms of the license agreement]

(_)1 do not accept the terms of the license agreement

n Select the folder where you want to install this software and then click Next.

Epson Device Admin - InstallShield Wizard X

Choose Destination Location

Select folder where setup will install files. @

(%

Setup will install Epson Device Admin in the following folder.

To install to this folder, click Next. To install to a different folder, click Browse and select
another folder.

Destination Folder

Device Admin¥ Browse...

Disk Capacity

w
i
T

< Back Cancel

11
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Note:
A Select Browse to change the destination where the software will be installed.

0 Select Disc Capacity to check the amount of free disc space.

Select the features that you want to add, and then click Next.

You can also add the alert feature and the report feature. See the following for information on additional
feature.

£ “Alert management” on page 19

£ “Report management” on page 20

Epson Device Admin - InstallShield Wizard X
Select Options

Select the options you want to install.
L 2

To install a feature, dick the check box next toit. If the check box is dear, that feature will not
be installed.

Alert Function
Email notification can be sent when a device is in an error state.
Report Function

Device usage reports can be automatically generated and sent.

<Back Cancel

E Make the database settings, and then click Next.

Select the folder where you want to install the database, and then enter the port number used to access to the
database.

Epson Device Admin - InstallShield Wizard X

Database Settings

Set the database information.
-

A folder to install database

son Device Admin

Browse...

Port Number

10015

Port number to access the database. Enter a port number that is not used
by other software and services.

12
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Note:
Select Browse to change the destination where the database will be installed.

Click Install.

Installation starts.

Epson Device Admin - InstallShield Wizard 4

Ready to Install the Program
The wizard is ready to begin installation.
h

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to exit
the wizard.

< Back Install Cancel

E Click Finish when the installation complete screen is displayed.

Epson Device Admin - InstallShield Wizard

Instalishield wizard Complete .
E -

The InstallShield Wizard has successfully installed Epson Device Admin. Click Finish to exit the
wizard.

Launch Epson Device Admin

e e

Changing features and uninstalling

You can change the installed features and uninstall this software from the Windows Control Panel.

Open the Windows Control Panel.

Select Uninstall a program to display the program list.

13
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Right-click Epson Device Admin.
n Select one of the followings from the menu displayed.

To change a function: change

To uninstall the software: uninstall

Follow the on-screen instructions to uninstall or change this software.

Updating

The following information and files are maintained even if you install an updated program or change the features.
4 Information on acquired devices

[d  Settings for the discovery parameters

[ Database files (From Epson Device Admin 2.x or later)

Starting up and closing Epson Device Admin

A Start up
Select Start menu - All Programs - EPSON - Epson Device Admin - Epson Device Admin.
4 Close

Click "x" at the top-right of the screen, or click at the top-left of the screen, and then select Close.

System settings

You can configure Email settings and ribbon menu settings for management by using the option menu in the ribbon
menu on the device management screen.

See the following for more details.

£ “Operation Settings” on page 23

14
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Operation Screen

Operation Screen

Top Screen

1

Epson Device Admin — O x
3 9 63 EH — i ] @o Add (e Undo | g o
= = = ©] =V . i " . % B Delete - .
All Selected Auto-Update Device Embedded Web | Apply Configuration | Save as Configuration  Print Status | Discovery Firmware  Options
Devices Devices Configuration Server Template Template Sheet(s) -
Update Device Information Configuration Status Sheet Device List Option
4 (@ Default Groups Search Filter “ General -
i All Devices (10) Madel MAC Address P Address [status Last Upd| Manufacturer EPSON
B New Devices (0) Series 192.168.0.200 @ Error 1/28/201] Model series
B Configured Devices (0) 192,168,052 Idle status 1/28/2014 DNS Name
B Ungrouped Devices (5 Series 192,168,055 ) Ink: Follow the m... 1/28/2011 MAC Address
3 Warning Devices (2) - 102.168.0.54 \dle status 17287201 IP Address 192.168.0.60
B Error Devices (3) | Series 192168060 Idle status 17287201 Serial Number TWES101042
B Unrespansive Devices (0 192,168,057 © Ink: Follow the m... 1/28/201 Last Update 1/28/2016 8:14:22 AM
# [ User Defined Groups ) Series 192.168.0.56 ! Ink low. (Magent.. 1/28/2011 Last Update (UTC) 1/28/2016 4:14:22 PM
4 o Pers offic= (2) 3) 192.168.0.58 Idle status 1/28/2011 Memory 128
B Sales div. (3) Series 102.168.0252 U Inklow. (Cyan) 172872011 Rear Paper Feed Installed
Series 192.168.0,100 Idle status 17287201 FAX Installed
4 5 Registered Date 6 1/28/2016 8:14:16 AM
“ Firmware
Version SELFO1FO
4 Status
Status Code 0004
Status Idle status
Status Last Updated  1/28/2016 8:14:25 AM
4 Supplies Last Updated
Supplies Last Updated  1/28/2016 814:25 AM
4 Cyan Ink
Level I |
— Maodel Number Cyan Ink Cartridge 16
=P Devices 4 Magenta Ink
T 2 Level ——
. Model Number Magenta Ink Cartridge
é Reports < Yellow Ink
§ ] 3 Level [ |
EH_configurstion Total: 10 - Error: 3 - Warning: 2 - Unresponsive: 0 - Unknown: 0 - Ready: 5 /10 WModel Mumber Vellow Ink Cartridae 167
by Intranet access ] 7
7

The Epson Device Admin top screen is composed of the following panes.

The display changes depending on the item selected from the side bar task menu on the top screen.

No. Pane Explanation

1 Title bar CIicktheﬂtoopen the Help to view explanations of each itemin Epson Device Admin.

2 Side bar task menu Changes the feature being used. The screen switches depending on the item selected.

3 Ribbon menu Displays the menu for the feature selected on the side bar task menu.

4 Side bar content Displays the hierarchy for the feature selected on the side bar task menu.

5 Display view Displaysinformation and setting content depending on the feature selected in the side
bar task menu or the side bar content.

6 Detailed device Displays details on the device selected from the Device List when you select Devices on

information the side bar task menu.

7 Status bar Displays status information on the Device List when you select Devices on the side bar

task menu.

15
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Summary of Each Main Screen

Side bar task menus

E Devices
‘-_ Alerts

é Reports

E3 configuration

Select a menu to switch from one menu to another.

4

Device management screen

Allows you to manage devices on the network. You can discover and register devices, as well as update device
information and so on.

£ “Device management” on page 17
Alert management screen

Allows you to manage alerts that are output from the device. The system can automatically inform you via email
about devices with low supplies level, paper jam or device error.

£ “Alert management” on page 19

Report management screen

Allows you to manage reports that contain a variety of information about the devices. You can set how to output
reports containing information such as the frequency the device is used and the number of times consumables are
replaced.

£ “Report management” on page 20

Configuration template management screen

Allows you to manage settings for devices with templates. You can make settings for creating, applying, and
backing up setting templates.

£ “Configuration template management” on page 21

16
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Device management

)] Epson Device Admin - 0 x
Home View Groups @
Q. 9 3] - _ + @o Add e Undo |

= = = ,5_‘1 . i % [ Delete Redo o a
All Selected  Auto-Update Device  Embedded Web  Apply ConfigBtation | Save as Configuration  Print Status  Discavery Firmware | Options
Devices  Devices Configuration Server Template Template Sheetis) -
Update Device Information Configuration Status Sheet Device List [*]
4 [aw Default Groups Search Filter 4 General
i All Devices {10} Model MAC Address IP Address [status Last Upds Manufacturer EPSON
B New Devices (0) Series 192.168.0.200 S Error 1728/201¢ Model Series
= Configured Devices (0) 192.168.0.52 Idle status 1/28/201¢ DNS Name
B Ungrouped Devices (3) Series 192168055 ) Ink: Follow the m... 1/28/201¢ MAC Address
3 Warning Devices (2) 192.168.0.54 \dle status 1/28/201¢ |P Address 192.168.0.60
B Error Devices (3) Series 192.168.0.60 Idle status 1728/201¢ Serial Number TWE101042
= Unrespansive Devices (0] 192.168.0.57  Ink: Follow the m... 1/28/201¢ Last Update 1/28/2016 81422 AM
“ [ User Defined Groups Series 192.168.0.56 U Ink low. (Magent... 1/28/201¢ Last Update (UTC) 1/28/2016 4:14:22 PM
# [ Peris office (21 () 192.168.0.58 Idle status 1/28/201¢ WMemory 128
B Sales div. (3) Series 192.1680.252 U Inklow. (Cyan)  1/28/201¢ Rear Paper Feed Installed
2 Series 31 92.168.0.100 Idle status 1/28/201¢ FAX Installed
Registered Date 1/28/2016 8:14:16 AM
4 Firmware
Version SELFO1FO
4 Status
Status Code 0004
Status Idle status
Status Last Updated  1/28/2016 8:14:25 AM
4 Supplies Last Updated
Supplies Last Updated  1/28/2016 &14:25 AM
4 Cyan Ink
Level I |
— Maodel Number Cyan Ink Cartridge 165
= Devices 4 Magenta Ink
Level I I
* Alerts Model Number Magenta Ink Cartridge
g Reports 4 Yellow Ink
. 1 ¥ Level | |
B configuration 5 Total: 10 - Errar: 3 - Warning: 2 - Unresponsive: D - Unknawn: 0 - Ready: 5 Model Number Vellow Ink Cartridas 16
T INTranet access
L Q
O

Displays the device management screen when selecting Devices on the side bar task menu.

The device management screen is comprised of the following panes. See the following for available operations using
the device management screen.

5 “Installation Settings” on page 23

No. Pane Explanation

1 Ribbon menu Therearethreeribbons onthe device management screen,and you can switch between

them by clicking the tabs.
d Hometab

Allows you to discover devices on the network, update information, change
settings for the device, apply templates, and so on.

d Viewtab
Allows you to set and change information displayed on the Device List.
[  Groups tab

Allows you to make settings to manage devices in groups.

17
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No. Pane Explanation
2 Tree view Displays setting groups in a folder tree formation. You can display groups that are set
automatically and user defined groups. You can also display the number of the devices
that belong to each group.
The number of devices is displayed as shown below.
1 Groups that are set automatically
Group name (the number of devices that belong to the group)
d  Groups defined by the user
Group name (the number of devices that belong to the group) (the number of
devices that belong to the child group*)
*If the same device belongs to multiple different child groups, it is counted as one
device for each group. In that case, an * (asterisk) is displayed.
3 Device list Displays thelist of registered devices. You can check the device'sinformation and status.
4 Device detailed Displays detailed information for the device selected in the Device List. The displayed
information screen items vary depending on the device. This is not displayed when multiple devices are
selected.
5 Summary bar Displays a summary of devices registered in the Device List with information such as the
number of devices.
6 Status bar Displays the network connection status of the computer as an icon and text.

The following status is displayed.
4 Internet access

The computer is connected to the internet.
(4 Intranet access

The computer is connected to the internal network, but not connected to the
internet.

(d  Not connected

The computer is not connected to the network.

18
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Alert management

B Epson Device Admin - 80 x
rome >0
PR
(] (<] -
o g e
New  Edit Duplicate Delete  Assign/Remove 1
Groupls)
Alert Management Subscribe
4 B Aeris Alert Name |Adert Type Subscribed Group(s) | Alert Notification
Aanq Supply level low Supplies level low 2 [Tadmin-+supply@epson.com
M Subscribed Alerts (1)

£ Unsubscribed Alerts (0)

Eilogs (1) 3

2 Alert Name: Supply level low
Group Name Number of devices
"\Paris office 2
\\Paris office\Sales div. 3
=P Devices
‘ Alerts
g Reports

E Configuration

F Intranet access

Displays the alert management screen when selecting Alerts on the side bar task menu.

The Alert management screen is comprised of the following panes. See the following for available operations using the
Alert management screen.

£5° “Managing Alerts” on page 82

No. Pane Explanation
1 Ribbon menu Creates alerts and manages information.
2 Tree view Switches the display for alert template classifications.
3 Alert list Displays the alert template list when anything except for Logs is selected in the tree

view. Displays the logs list when Logs is selected in the tree view.

4 Alert group Displays the groups subscribed to the alert templates selected in the alert template list.
Displays log details when Logs is selected in the tree view.

19
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Report management

@ Epson Device Admin - O x
Home 2@
—
g e a e
Mew  Edit Duplicate Delete 1
VI P f
4 ZDatabase Report Name Collecting Conditions  |Last Creation Date | Destinations
= Data Collection Device Usage Device Usage [Tadmin+report@epson.com
4 H User Defined Report Device Usage Monthly Device Usage 9/17/2015 8:35 AM
Bl Scheduled Reports(2)
B Archived Reports(1)
2 Report Name: Device Usage Monthly
Collecting Conditions Device Usage
Groups \Paris office;\Paris office\Sales div. 3
Report Format
File format HTML
Primary sort Model
Primary sort Ascending order True
Secondary sert None
Secondary sort Ascending order False
Device Information Model;IP Address;MAC Address
Data Column Total Pages:Mono Pages:Color Pages
Date Range
Report Interval Weekdy
E Devices Last 1 Manth
from Genersted date
‘ Alerts .
. Email
g Reports Type Archive only
To
BB configuration Subject Report from Epson Device Admin
rh Intranet access

Displays the report management screen when selecting Reports on the side bar task menu.

The Report management screen is comprised of the following panes. See the following for available operations using
the Report management screen.

£ “Report Management” on page 88

No. Pane Explanation

1 Ribbon menu Switches the ribbon menu according to the tree view selected on the report
management screen.

(J Database - Data Collection
Menus for data collection.
d User Defined Report - Scheduled reports
Menus for creating reports and formatting.
 User Defined Report - Archived Reports

Menus for report files.

2 Tree view Displays data collection and report management trees. The ribbon menu and display
view are switched depending on the selected item.
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No. Pane Explanation

3 Display view Displays the following depending on the item selected in the tree view.
(1 Database - Data collection
Top area: List of data collection conditions

Bottom area: List of devices

(1 User Defined Report - Scheduled reports
Top area: List of report schedules
Bottom area: Details about the selected schedule
1 User Defined Report - Archived Reports

Top area: List of archive reports

Bottom area: Content of the selected archive report

Configuration template management

€]
Home

Epson Device Admin

e @ e

New Edit  Duplicate Delete

Report Management

Export Database

1

—
4 =Database

EData Collection

4 B User Defined Report
El Scheduled Reports(2)
B Archived Reports(1)

2

E Devices
‘ Alerts

Q

é Reports

BEH configuration

Report Name

Device Usage

Device Usage

4

Report Name: Device Usage

Data Type
Groups
Report Format
File format
Primary sort
Primary sort Ascending order
Secondary sort
Secondary sort Ascending order
Device Information
Data Column
Date Range
Report Interval
From
To
Email
Type
To
Subject

|Data Type

Device Usage

Device Usage

Device Usage

“Paris office;\Paris office\Sales div.

PDF

Model

True

None

False

Maodel;MAC Address;IP Address
Total Pages:Mono Pages:Color Pages

Per Month
1 Month ago
Generated date

Archive only

Report from Epson Device Admin

‘Last Creation Date

1/28/2016 8:37 AM

|Dastlnatluns

[Tadmin+ report@epson.com

rhy Intranet access
o

Displays the configuration template management screen when you select Configuration on the side bar task menu.

The configuration template management screen is comprised of the following panes. See the following for available
operations using the configuration template management screen.

£ “Settings Template” on page 44

No. Pane Explanation

1 Ribbon menu Manages configuration templates.
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No. Pane Explanation

2 Tree view Displays configuration templates in a folder tree formation. Switches display views
depending on the selected item.

3 Display view Displays the following depending on the item selected in tree view.

d Configuration - Templates

Top area: List of configration templates

Bottom area: Content of the selected configuration template
O Configuration - Logs

Top area: List of logs

Bottom area: Content of the selected log
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Installation Settings

Operation Settings

These settings are necessary to use each feature.
Device Registration
4 Discovery Parameters: Discovery using an IP address
£ “Specifying an IP address” on page 31
4 Discovery Parameters: Discovery using an IP address range
£ “Specifying an IP address range” on page 32
4 Discovery Parameters: Discovery using a network address
£ “Specifying a network address” on page 32
System Settings
d  Email notification settings
£5° “Mail” on page 25
A Processing Time
£ “Schedule settings” on page 77
4 Password Manager
£5° “Managing passwords automatically” on page 56
4 System settings
£ “Backing up system settings” on page 107
Detailed Settings
d " Firmware external site access
£ “Check for updates” on page 29
4 Detailed Settings
£5° “Formats” on page 27

Alert Notifications
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d  Alert

£ “Setting the alert confirmation interval” on page 85

Options screen

You can set discovery conditions as well as system settings on the Option screen.

Select Devices on the side bar task menu.

| E Devices

A nlerts

é Reports

EA configuration

Select Home - Options on the ribbon menu.

A Epson Device Admin

Ve Croves

2 = +
= = 0O e = ]

Al Selected  Auto-Update Device  Embedded Web  Apply Configuration ' Save as Configuration ~ Print Status
Devices  Devices Configuration Server Template Template Sheet(s)

Update Device Information Configuration Status Sheet

Add
%
B3 Delete

Discovery

Device List

Select the item you want to configure.

Set each item as necessary.

™ Undo

[$

&, o
Check date

Updates

Options

Firmware Ootions

B options

Discovery Parameters Descovery Parameters
1P Address [ Enabie discovery with IF address
IF Address Range
Hetwork Address

Mail

Timing

Formats

Alert Notifications

1P Address

Configuration Template
Startup

Customize Ribbon
Password manager
Check for updates
System Administration

Backup/Restore

IF you change the search conditions, you may find & new device after searching,

Click OK.
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Mail

You can set the email server (mail sending server) used for the notification feature.

B options ®
Discovery Parameters Email Server Settings
1P Address Hest namaP address 192.168.0.215 Part number 2 (]

IP Address Range
i Address
ma

Connect using STARTTLS encryption

Sender's emad address

Timing EDAmanageepsan.com
Formats Maxdmum attachment size
Alent Notifications 5

I
Configuration Template ME]
Srartup

Customize Ribbon Server authentication settings

Fassword manager Server authentication setlings
Check for updates & SMTP Auth FOF before SMTP

System Administration
Backun/R + Same as the sending server
Backup/Restore

Send Test Message

oK Cancel
Items Explanation
Host name/IP address Enter the host name or IP address for the SMTP server.

Enter the host name within 255 characters using Ato Z, ato z, 0 to 9, hyphens (-), and
underscores (_). The label should be within 63 characters.

Enter the IP address in IPv4 format using numbers and periods (.).

Port number Enter the port number for the SMTP server from 1 to 65535.

|§| Check the connection with the SMTP server.
Blue: Successfully connected to the server. Go to the next step.
Red: Failed to connect to the server.

If the software fails to connect to the server, check that all settings have been made

correctly.
Connect using STARTTLS Select this to encrypt the connection to the SMTP server.
encryption
Sender's email address This is the email address displayed in the email header sent from the system.

Enter up to 256 characters.

Maximum attachment size | Specify the maximum attachment file size for email.

Server authentication Select this if the server requires authentication to send emails.

settings Select the authentication method from SMTP Auth (SMTP authentication) or POP before
SMTP.

Host name/IP address Enter the host name or IP address for the authentication server when the authentication

method is POP before SMTP.
The entered text is the same as the host name and IP address for the SMTP server.

When this is the same as the authentication for the SMTP server, select Same as the
sending server.
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Items Explanation
Login ID Enter the login ID for the SMTP server using up to 255 ASCII characters.
Password Enter the password for the SMTP server using up to 255 ASCII characters.
Send Test Message Check whether or not the test email can be sent to the receiver's email address.

This button is available once the host name/IP address, port number, and sender's email
address have been entered. For the test email, the title "Epson Device Admin" and body
text "Success. Email settings are correctly configured." are displayed in English regardless
of the language setting.

Timing

Set timing of data collection and logs retention period.

B options )
Discavery Parameters Data Collection Time
1P Address | Dewice Lsage
IP Address Ra
ddress Range +f| supplies Usage

Network Address
Mad

| Accessones Inventory

. | Hourly Peak Usage

Formats

Dt retention period
Alert Notifications e

Configuration Temgdate bevices Deta

Startup Generated reparts
Customize Ribbon
Password manager
Check for updates

Log retention period
Logs 0 Day

T A
System Administration Update Device Information
Back /Restorn
Backup/Restore ® Refresh interval o0 E>
Select the day of the week Manday Tuesday Wednesday Thursday
Friday Saturday Sunday
Restore Default Seltings
oK Cancel
q
Item Explanation

Update Device Information | Sets the schedule to collect information about the devices using Auto-Update on the
Device management screen.

Refresh interval Collects device information at setintervals. You can set the interval time from 1 minute to
23 hours and 59 minutes in intervals of 1 minute.

Select the day of the week | Collects device information on the selected day and time. You can specify the time in
intervals of T minute.
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Formats

Set the data delimiters, paper size, and units for the report.

B opticns x
Discovery Parameters Format
IP Address C5V data delimiter
IP Address Renge ® ~" (Comma) “" (Semicolon)
Network Address Paper Size Reference
Mail ® ad Letter Ad/Letter
Timing Unit
Iy ™ ® Meter (m) Feet (ft)
Configuration Template Restore Defaull Settings
Startup
Custormuze Ribbon
Pagsword manages
Check for updates
System Administration
Backup/Restare
oK Cancel
Item Explanation
CSV data delimiter Specifies data delimiters for CSV files when saving reports, archive reports, and so on.
The default value is ",".
7 “Report Management” on page 88
Paper Size Reference Displays the paper size selected in this software. The default value is A4.
Unit Displays the units selected in this software. The default value is Meter (m).

Startup

Sets whether or not to collect device information when you start this software.

B options ®
Discovery Parameters Device Management
1P Address ("] Update device data at startup
IP Address Range
Netwark Address Discovery Timeout (10-180) 60 Second(s)
Mad
fimng Restore Default Settings
Formats

Alent Notifications.

Configuration Temg

Customize Ribbon

Password manager
Check for updates
System Administration
Backup/Restore

oK Cancel
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Item

Explanation

Update device data at
startup

Sets whether or not to collect all device information when you start this software.

£ "Updating Device Information” on page 34

Discovering and rebooting
timeout (10-180)

Specifies the timeout time between the discovery and the reboot confirmation. You can
specify 10 to 180 seconds in intervals of 1 second. The default is 60.

£ "Discovery condition settings” on page 31

Customize Ribbon

Set the ribbon menu display.

B options

Discovery Parameters
IP Address
IP Address Range
Network Address

Ma

Timing

Formats

Alert Notifications

Configuration Template

Ribbon Menu
Show Batch Settings button

Show Reset, Open, and Save buttorns in the Device List

Restore Default Settings

Password manager
Check for updates
System Administration

Backup/Restore

oK Cancel

Item

Explanation

Show Batch Settings

When this is selected, the Batch Settings button is displayed on the Home tab - Setting

button group on the ribbon menu for the Device Management screen.
£ "Batch Settings” on page 125
Show Reset, Open, and When thisis selected, the Reset, Open, and Save buttons are displayed on the Home tab -
Save buttons in the Device | Device List group on the ribbon menu for the Device Management screen.
List

7 "Device list” on page 109
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Check for updates

Allows the software to access external sites to update this software or check and obtain firmware updates.

x

B options
Discovery Parameters Chedk for updates
P Address Epson Device Admin
P Address Range Check for software updates at stanup
Network Address Firmware
Ma Enable Update button
Timing Check for firmware updates at startup
Formats
Alert Notifications Internet access is requined
Configuration Temglate
Startup
Rastere Default Settings

Customize Ribbon

Backup/Restore
oK Cancel

Item Explanation
Checkforsoftware updates | Checks for updates for the firmware at startup.
at startup
Enable Update button Allows the software to access external sites to check for firmware updates for devices.
Check for firmware Checks for updates for the firmware at startup.
updates at startup

Registering to the device list

Registers devices managed on the network to the device list.
You can use the following registration methods. Use the method that best suits your daily operation needs.

d Discover and register devices

Discover devices on the network and register them to the software. You can discover using conditions such as
beyond segment and specify network range.

£ “Discovering devices” on page 30

d  Specify individually and register

Specify the IP address and device ID and register it to the software. You can register specific devices or devices that
were not found during a discovery.

£ “Specifying individual devices” on page 33
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[d  Register from a device list file

Load a device information file containing the device list and register them to the software. This is useful when
restoring or migrating a system.

£ “Backing up and Restoring” on page 106

@ Epson Device Admin - O x
Home View Groups ] 0
Q o —

Tk o B 5 R
Al Selected  Auto-Update Device  Embedded Web | Apply Configuration | Save as Configuration  Print Status  Discovery Firmware ~ Options
Devices Devices Configuration Server Template Template Sheet(s) -
Update Device Information Configuration Status Sheet Device List Option:
4 [ Default Groups Search Filter 4 General -
i All Devices (10) Mol MAC Address IP Adress [status Last Upds Manufacturer EPSON
i New Devices (0) 9 Series 192.162,0200 @ error 1/28/201¢ Modz| Series
i Configured Devices (0) 192.168.0.52 Idle status 1728/201¢ DNS Name
i Ungrouped Devices (3) ¢ Series 192.1680.55 D Ink: Follow the m... 1/28/201¢ MAC Address
3 Warning Devices (2) 192.168.0.54 dle status 1/28/201¢ IP Address 192,168.0.60
B Error Devices (3) Series 192.168.0.60 Idle status 1/28/201¢ Serial Number 1WE101042
B Unresponsive Devices (0) 192,168.0.57 @ Ink: Follow the m... 1/28/201¢ Last Update 1/28/2016 8:14:22 AM
# [ User Defined Groups ) Series 192.168.0.56 ¥ Ink low. (Magent... 1/28/201¢ Last Update (UTC) 1/28/2016 4:14:22 PM
4 o Pars office (21 (3) = 192,166.0.58 idle status 1/28/201¢ Memary 128
B Sales div. (3) Series 192.168.0252 U inklow. (Cyen)  1/28/201¢ Rear Paper Feed Installed
Series 192.168.0.100 Idle status 1728/201¢ FAX Installed
Registered Date 1/28/2016 8:14:16 AM
4 Firmware
Version SELFOTFO
4 Status
Status Code 0004
Status Idle status
Status Last Updated  1/26/2016 8:1425 AM
4 Supplies Last Updated
Supplies Last Updated ~ 1/28/2016 8:14:25 AM
4 Cyan Ink
Level | |
= Model Number Cyan Ink Cartridge 16
¥=F Devices 4 Magenta Ink
A s Level I |
v Model Number Magenta Ink Cartridge
g Reports 4 Yellow Ink
. ] ¥ Level | |
E8 configuration Total: 10 - Ervor: 3 - Waming: 2 - Unresponsive: 0 - Unknown: 0 - Ready: 5 1/ 10 Model Number Yellow Ink Cartridae 167
_r!'\_ Intranet access

Discovering devices

When you start Epson Device Admin, it automatically discovers devices in the same segment and registers Epson

devices to the device list.

Note:
Click the £ icon next to the progress bar to stop discovering.

Discovering by using the discovery button

This discovers using the conditions set on the device management screen.

Select Devices on the side bar task menu.
Click Options on the ribbon menu.

Set the appropriate conditions for the device you are discovering.

See the following for details.
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25 “Discovery condition settings” on page 31

n Click OK when you have finished setting the conditions.

Click Discovery.

The software starts discovering and registers located devices to the device list.

When you click Device List - Save on the ribbon menu, you can save the displayed device list to a file. However,
group information is not saved.

£ “Backing up and Restoring” on page 106

Note:

assigned.

A When the software is connected to a network, it discovers for Epson devices even if no IP addresses have been

A Devices that are connected to computers on the network by USB cables are discovered when the Epson Device
USB Agent is installed on the computer. See the manual for the Epson Device USB Agent for details.

Discovery condition settings

Sets the conditions for discovering. You can discover by specifying IP addresses, an IP address range, and network
addresses. You can discover when an IP address is assigned to a device. See the following for details.

Note:

conditions.

(10-180)

0 All enabled discovery conditions are performed in parallel.

0 Epson devices in the same segment as Epson Device Admin can be discovered for regardless of the discovery

0 Set the timeout for discovering from Options - Startup - Devices - Discovering and rebooting timeout

Specifying an IP address

Discovers for the specified IP address for the device using unicast.

Note:

details.

When you want to discover the device connected to the computer with a USB cable, specify the computer's IP address.
You need to install the Epson Device USB Agent on the computer. See the manual for the Epson Device USB Agent for

Item

Explanation

Enable discovery with IP address

Select to enable this discovery condition.

Add

Displays the screen where you can add an IP address

Enter the IP address for the device you want to discover in IPv4 format.

You can register up to 100 IP addresses.
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Item Explanation
Delete Deletes the selected IP address from the IP address list.
Up, Down Moves the IP address up or down in the IP address list.

The discovery is performed in the order of the addresses in the IP address list.

Restore default settings

Click this to clear the IP address list and disable discovering using IP addresses.

Specifying an IP address range

Discovers the specified IP address range for the device using unicast. You can perform this discovery when an IP

address is assigned to the device.

Note:

Devices that are connected to computers on the network by USB cables are discovered when the Epson Device USB
Agent is installed on the computer. See the manual for the Epson Device USB Agent for details.

Item

Explanation

Enable discovery with an IP address
range

Select to enable this discovery condition.
Discovers devices within the selected IP address range.

Add Displays the screen where you can set an IP address range.
Enter the start and end IP addresses for the range you want to discover in IPv4 format.
You canregisterarange of up to 20 IP addresses. You cannot register the discovery if the
number of the IP address range exceeds 65536.

Change Changes the IP address range specified for the device selected in the discovery range.

Delete Deletes the IP address range specified for the device selected in the discovery range.

Restore default settings

Click this to clear the discovery range and disable discovering using a range of IP
addresses.

Specifying a network address

Discovers a device in the specified network address using multicast.

Item

Explanation

Enable discovery with multicast

Selectthis to send data to the specified network using port number 427 and multicastto
discover a device.

You need a router environment that supports IP multicast.

Enable discovery over network
segments

Select this to discover devices on networks beyond your router.

Sends data to the specified network using port number 3289 and broadcast to discover
a device.

When sending using multicast, you can set the network range to be discovered in
Multicast TTL (1-15).
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Item Explanation

Add Displays the screen where you can specify a network address.

Enter a network address and subnet mask in the subnet in IPv4 format. When the
entered networkaddressisthe hostaddress, itis automatically corrected and registered
to the discovery address list.

You can register up to 20 network addresses.

Delete Deletes the selected network address and subnet mask from the discovery address list.

Multicast TTL (1-15) Sets the network range to be searched when sending by multicast. When setto "1", the
router is not passed through. When set to "2" or higher, the network range specified in
Network to discover is discovered.

Restore default settings Click this to clear the discovery range and disable discovering using a range of IP
addresses.

Specifying individual devices
You can register devices that were not found using the discovery feature, or devices that were not made by Epson.

Select Devices on the side bar task menu.
Click Device List - Add on the ribbon menu.

Select a method to classify the device.
Select IP Address when the device has a static IP address.

Select DNS Name when the IP address for the device is set automatically.

@ Add device X
Added by IP Address -
IP Address
Device Information DNS Name

OK Cancel

n Enter the device information.
Enter the IP address in IPv4 format when you select IP Address as the method.

Enter the device name on the network when you select DNS Name as the method.

Note:

When you want to discover the device connected to the computer with a USB cable, specify the computer's IP address.
You need to install the Epson Device USB Agent on the computer. See the manual for the Epson Device USB Agent for
details.
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Click OK.

When communication is successful, the device is registered to the device list.

If it is not registered, make sure the IP address and domain name are correct.

Updating Device Information

You can update detailed information about the status of devices registered in the device list and the status of
consumables. The ribbon menu is unavailable when device information is being acquired.

Select Devices on the side bar task menu.

Click Update Device Information - All Devices on the ribbon menu.

When updating data individually, select the device from the device list, and then click Update Device
Information - Selected Devices.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.

You can update device information automatically.
4 Update when starting Epson Device Admin

Select Options - Startup - Device Management - Update device data at startup.
4 Update regularly by using a timer

You can update data regularly by setting a schedule. See the following for details.

5 “Collecting information regularly” on page 77

Group Management

You can manage devices registered to the device list as separate groups. The groups are displayed in the tree view when
you select Devices on the side bar task menu.

You can create groups for specific purposes, such as the location devices are installed, organization names, different
features of the printer or scanner, available paper sizes, and then manage the devices as groups.

You can use the following methods to register devices to a group.
[d  Assign automatically using set conditions

Discovered devices are assigned automatically using set conditions.
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[ Select devices

Select devices and register them to a group. You can create a group from the selected devices.

Create and edit user-defined groups

You can manage devices as a group by creating optional groups such as for the office and department of the device.

Create an automatic assignment group

Devices discovered through a search are automatically assigned to a group. Follow the steps below to set the conditions
for assigning groups.

Note:
You can create up to 2,000 groups. There is no limit for groups in the same layer.

Select Devices on the side bar task menu.

Click the Groups tab on the ribbon menu.

Click New.
B Epson Device Admin - @ x
Home View Groups @
N+ -
[ ] K~

New Add/Remove
Gevicels)

Groups Devices

Select the group name to use as the parent from Parent group.

When creating a new group, layers are created by assigning the User Defined Groups as the parent group. You
can create up to eight layers of groups.

B Add group bt

Parent group

i1
\Paris office

\Pariz office\Sales div.

Group Name

[] Enable auto sorting

oK Cancel
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Enter the new group name in Group Name.

Enter up to 256 characters in Unicode for the group name. You cannot use \ or ;.

B Add group *
Parent group

\
\Paris office
\Paris office’Sales div.

Group Name

| Mew York of'Ficel

[] Enable auto sorting

0K | | Cancel
Click Enable auto filter.
Click Add.
The setting screen for automatically assigning groups is displayed.
Set the auto assignment conditions.
You can register up to 20 conditions.
E Auto sorting - O X
Cevice information Location v
Conditions Include ¥
Value |Paris’ |
Operation ® AND O OR

QK | | Cancel |

See the following to make the settings.
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Item Explanation

Device Information Items in the device list column. Select the following from the pull-down menu.
d  Model

IP address

Department

Location

Remark

Remark 2

Groups

Connection

OUd o0 dodd

Manufacturer

Conditions Select conditions for the target items.
1 When Device Information is set to IP Address:
Greater than or equal to
less than or equal to
Greater than
less than
Equal to
Not equal to
Start with

When Device Information is set to Model, Department, Location, Remark or
Remark 2:

Equal to
Not equal to
Include
Not include
Start with
End with
d  When Device Information is set to Groups:
Belong
Not Belong
T  When Device Information is set to Connection:
Equal to
Not equal to

Value When Device Information is set to IP Addresss, enter the IP address.
When Device Information is set to Connection, select Network or USB.

For other situations, enter up to 256 characters in Unicode.

Operation Selects the relationship to the last condition. The conditions are applied in order from the
top of the auto sorting conditions.
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E Click OK.

The automatic assignment condition is added in the list.

@ Add group

Parent group

i1
\Pariz office

\Paris officelSales div.

Group Name

Mew York office

Enable auto sorting

Device infarmation Conditions Operation Value

Location Include AND Paris

| ok

‘ ‘ Cancel

To continue adding the auto assign groups, click Add.
Click Edit to edit the group in the list.
Click Delete to delete the group from the list.

Click A or v tochange the order of the conditions.

Click OK.

The newly created group is added to the tree view.

Add a device by creating a group

Register devices to the group after creating the group.

Note:
You can create up to 2,000 groups. There is no limit for groups in the same layer.

Select Devices on the side bar task menu.

Click the Groups tab on the ribbon menu.
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Click New.

)] Epson Device Admin - & X
Home View Groups ]
=&

] [ &4
Edit  Delete  Add/Remove
device(s)

Groups Devices

Select the group name to use as the parent from Parent group.

When creating a new group, layers are created by assigning the User Defined Groups as the parent group. You
can create up to eight layers of groups.

@ Add group

Parent group

B

\Paris office

\Paris office’Sales div.
\New York office

Group Name

[[] Enable auto sarting

Enter a new group name in Group Name.

Enter up to 256 characters in Unicode for the group name. You cannot use \ or ;.

ﬂ Add group

Parent group

i1
\Pariz office
\Paris officelSales div.

\Mew York office

Group Name

|London of‘ﬁcd ]

[[] Enable auto sarting
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E Click OK.

The new group is added to the tree view.

4 gy Default Groups
il Mew Devices (0)
i Configured Devices (0)
| Ungrouped Devices (5)
£ Warning Devices (2)
Em Error Devices (3)
B Unresponsive Devices (0)
4 [ User Defined Groups
4[5 Paris office (2) (5)
i Sales div. (3)
B Mew York office (0)
il London office (0)

Click Add/Remove device(s) on the ribbon menu.

Home View Groups

Epson Device Admin

[

> @

el [
New  Edit Delete fAdd/Remove
devicels)
Groups Devices

E Select the group to which you want to add the device, and then click Next.

The device list is displayed.

E Add/Remove device(s) — O *

Select Groups

“\Paris office

\Paris office\Sales div.
\Mew York office
“London office

MNext | Cancel

E Select the device you want to register.

Select devices to register by Select devices and then click >

Note:
To delete devices from the list, select the device in Added devices, and then click <
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B ~dd/Remove device(s)

Select devices

Added devices

Model IP Address. MAC Address

WP-4530 Series 192.168.0.55 00:26:AB:A8:98:28

Model

IP Address

MAC Address

WF-R8590 Series
WF-2630 Series

XP-410 Series

192.168.0.51

192.168.0.50

192.168.0.59

ALEESTFRERAF

AC:18:26:FB:80:43

A4EESTFOA0:20

Click OK.

Group editing
Change group names and parent groups in higher layers.

Select Devices on the side bar task menu.

Click the Groups tab on the ribbon menu.

Click Edit.

Epson Device Admin

X~
Add/Remove
device(s)

Devices

n Select the group name to be edited from Parent group.

ﬂ Edit group

Parent group

A\
\Paris affice
\New York office

\Lendon office

Group Name

Sales div.

Enable auto sorting

QK

| | Cancel

1

F X
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Change the group name in Group Name.

If you want to change parent groups, enter the name from the parent group name.

ﬂ Edit group
Parent group

A\
\Paris affice
\New York office

\Lendon office

Sroup Name

Sales and Meketind div.

Enable auto sorting

| | Cancel

E Click OK.

The changes are reflected in tree view.

4 [ Default Groups

il All Devices (10)

i New Devices (0)

i Configured Devices (0)

i Ungrouped Devices (5)

£ Warning Devices (2)

i Error Devices (3)

B Unresponsive Devices (0)
4 [aw User Defined Groups

4 [ Paris office (2) (3)

i Sales and Marketing div.

i Mew York office (0)
| London office (0)

Deleting a group

Select Devices on the side bar task menu.

Click the Groups tab on the ribbon menu.

Click Delete.

B Epson Device Admin

Home View Groups
-0 - <l = (=] -
H K. K-
New  Edit | Delete | Add/Remove
Gevicels)

Groups Devices
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n Click OK.

A screen is displayed asking you to confirm if you want to delete the group.

Deleting a group automatically deletes its sub-groups if there are any.

Click OK.

The changes are reflected in tree view.
Devices from deleted groups are displayed in Ungrouped Devices.

4 [ Default Groups

i Mew Devices (0)

i Configured Devices (0)

i Ungrouped Devices (5)

£ Warning Devices (2)

i Error Devices (3)

i Unrespansive Devices (0)
4 [aw User Defined Groups

4 [ Paris office (2) (5)
i Sales and Marketing div.
m London office (0)
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Device Management

This section explains how to configure one device at a time, and how to configure batch settings for multiple devices.

Device Settings

Configure settings for devices on the network individually or collectively. Apply configuration information as a
template or manage devices by exporting configuration information to a SYLK file.

See the following for details about the available methods.

Configuration template
£ “Settings Template” on page 44

Device properties and Embeded web server
£ “Setting or changing devices one at a time” on page 52

Batch Settings
£ “Batch Settings” on page 125

Settings Template

Set devices using a configuration template. A configuration template uses the device's property settings as a template,
and then applies the settings to other devices. You can manage setting information without relying on specific devices.

The following templates are provided as presets.
4 Factory default settings (Network I/F)

Return the network interface settings for devices to their default settings.
4 Factory default settings (All)

Return all settings for devices to their default settings.

Creating a configuration template

Divert the device settings, and then create templates.

d Create from configuration template management screen
Create by selecting a device to use as a configuration template.

[d  Create from device management screen

Create by selecting a device to use as a configuration template from the device list.

44



Epson Device Admin User Guide Win

Device Management

Creating from the configuration template management screen

Select Configuration on the side bar task menu.

Click Save as Template.

The device selection screen is displayed.

& Epson Device Admin
Home
[+) + [«] . 2
= = ® B8
Mew [Saveas] Edit Duplicate Delete  Apply = Import Backup
emplate]

Configuration Template

F X

> @

Select the base device to be used to create settings.
You can select groups to which devices are registered from the Select group(s) menu.

The base device must support unicast communication and the functions to be set.

[B save as a Configuration Template - m] ®
ISe\ect groupls) All Devices ® I
Model 1P Address MAC Address |
WP-4530 Series 192168055 00:26:AB:A8:98:28
WF-R8590 Series 192168051 ALEESTIFFERAF
WF-2630 Series 192168050 AC18:26:F8:80:43

XP-410 Series 192.168.0.59 ALEEST:FOAD:20

For devices listed sbove, saving configuration template is available.

n Click OK.

The configuration template information edit screen is displayed.
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Enter information for each item.

Configuration Template Properties X

= Template A
. Information
£ Network Interface Author [epson |
- Information Comment ‘ |
- Network
Ethernet
Wi-Fi
Wi-Fi (Details)
TCpAp
Basic
Basic (IPv6)
DNS
DNS (IPv6)
ICMPv6
Bonjour
uenp
PP
sLp
Internet
wsD
LLTD
LLMNR
MS Network
Basic

Configuration Template Name: \Papersou.ce |

Printer
File
AppleTalk a4

Unselect All Cancel Help

Item Explanation

Configuration Template Name of the configuration template.

Name Enter up to 1,024 characters in Unicode (UTF-8).

Author Information on the creator of the template.

Enter up to 1,024 characters in Unicode (UTF-8).

Comment Enter optional information.

Enter up to 1,024 characters in Unicode (UTF-8).

E Select the check boxes next to the items to be setting values.

Note:

Some items are for writing only, and cannot be collected from the device and these fields are left empty. To make these
settings, you need to enter a value manually.

Configuration Template Properties X
- Template ~ | |[m Methodfor Speciying I Address
L E::::T::::Ece Method for Spectying IP Address ® Automatic ) Manual
Information [ Set using BOOTP
Network .
et [ ]Setusing RARP
Wi-Fi [ (/] Set using Automatic Private IP Addressing (APIPA)
Wi-Fi (Details) [ [ Set using PING
“TCP/IP
"Basic IP Address Setting
Basic (IPv6)
DNS IP Address [ |
- DNS (IPv6) Subnet Mask: [ |
ICMPYE
Borjour Defalt Gateway: [ ]
- UPRP
1pp
sLp
- Internet
- WSD
LLTD
- LLMNR
MS Network
Basic
Printer
. File
AppleTalk v
< >
Unselect Al Cancal Help
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Click Save.

The template is saved.

Creating from the device management screen

Select Devices on the side bar task menu.

Select the base device to be used to create settings from the device list.

The base device must support unicast communication and the features to be set.

Click Save as Configuration Template on the ribbon menu.

The configuration template information edit screen is displayed.

& Epson Device Admin
Home View Groups > @
@ o G = - > Gy @ 5
= €] = & @ O gow S,
Al Selected | Auto-Update Device Embedded Web  Apply Configuration [Save as Configuration | Print Status  Discovery . Check Options
Devices Devices Configuration Server Template Template Sheet(s) Updates
Update Device Information Configuration Status Sheet Device List Firmware Options
Note:

You can also select from the menu displayed when you right-click the selected device.

n Enter information on the configuration template.

See step 5 in the last item for details.

Change setting values as necessary, and then select the items you want to save to the template.

E Click Save.

The template is saved.

Applying configuration template

You can apply setting information to groups or individual templates by using a configuration template.
Items used to set target devices with the selected configuration template are applied.

You can apply settings using the following methods.

4 Select devices and apply

Select devices from the device list, and then select the configuration template. You can select devices to be applied
by confirming device information in the list.
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[d  Select configuration template and apply

Selecta configuration template from the configuration template management screen, and then select devices. You
can check the content of configuration templates in the list.

Note:
You cannot apply the configuration template to devices that are connected to computers on the network by USB
cables.

Select devices and apply

Select Devices on the side bar task menu.

Select the devices to which you want to apply the configuration template from the device list.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.

Click Apply Configuration Template on the ribbon menu.

The device selection screen is displayed.

B Epson Device Admin

Home View Groups @

o 9 G ;] - — + [ir) Add [A
= (=] ':‘l r o‘ 3 Delete O‘
All Selected Auto-Update Device Embedded Web | Apply Configuration JSave as Configuration  Print Status  Discovery Check Options
Devices Devices Configuration Server Template Template Sheet(s) Updates
Update Device Information Connguration Status Sheet Device List Firmware Options
Note:

You can also select from the menu displayed when you right-click the selected device.

n Select the configuration templates you want to apply from Select a configuration template.

B Apply Configuration Template to Devices - m} X

Select a configuration template

Location setting “

Default Settings (Network Interface)
Default Settings (All)
Paper source

Master template

Location setting

serruimu LevuiuD
o

Model MAC Address IP Address Groups Model MAC Address 1P Address Groups

PX-MT050FX B64EBACCAD2:01 192.168.052 WF-RE590 Series AAEESTFFESAR 192.168.0.200 \Paris ¢

EP-907F Series AC:18:26:FB:60:7B 192.168.0.55 \Paris ¢ WF-2630 Series AC:18:26:FB:80:43 192.1680.60 \Paris ¢
S

PX-ME6OF 192.168.0.54 \Paris ¢

PX-1700F 192.168.0.57

PX-M7050 Series 192.168.056

PY-MB50F 192168058

WF-7620 Series : 192.168.0.252 \Paris ¢

WF-5690 Series AAEESTFR62F3 192.168.0.100

Apply | [ cancel
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Check that the devices to which you want to apply the configuration template are in the list.

The devices to which the settings will be applied are in the Selected Target list. To change these, move devices or
groups by using > ,>> , < ,and <<

Use >  to move the selected device or group, and use >> to move all devices or groups.

Note:
d  When you select Devices and groups containing devices from the pull-down menu, each device is displayed.

1 Groupsaredisplayed when you select Groups. Select Include child group(s) to automatically select child groups
within the selected group.

B Appiy Configuration Tempiate 1o Devices

= O X
Salect 8 confijuration tEmplate
Location setting
Seleet Taiget
® Devices Al Devicas
OIS Include chald groupds)
Selectable Device/Group Sefected Device/Group
Made [MAL Adtelress IP Address Grougs Maxdel |MeAC Addiess |1 Addess [Grosips
PC-MTOSIR 192.168.0.52 WF-RESH0 Series BAFESTFRELAF 1921660200 "WParis c
EP-007F Series 192 1680.55 \Pars . WF-2630 Series ACUE 26 FR:BIAT 92, 16E.0:60 "WParks
P-Mb550F HAEROC:2541:C3 192.168.0.54 \Pare
3. 1T00F AAEESTAERRC 1L 188.0.57
PC-MTOS0 Series FF 192168056
PA-MGSIF 1921680 58
WF-TH20 Series 1921660252 \Para ¢
WF-S600 Savrisg 192.168.0.7100
<<
. ' ‘ "
Apply Canicel
Click Apply.

A confirmation screen for the configuration template to be applied is displayed.

Click OK.

A confirmation screen for the application results is displayed.

Check the content, and then click Close.

Apply 2 Configuration Template to Devices [ =]

Application result

Successful 2 Devices
Failed 1 Devices.
Unsupparted 0 Devices

You can check detailed information by clicking Details.
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Select configuration templates and apply

Select Configuration on the side bar task menu.

Click Apply.

The device selection screen is displayed.

B Epson Device Admin - & x
o] -0
[+] * [ 3
i =¥ &
New  Saveas  Edit Duplicate Delete | Apply | Import Backup
Template

Configuration Template

Select the configuration template you want to apply from Select a configuration template.

[B Apply Configuration Template to Devices - u] be

Select & canfiguration template

Location setting -

| Default Settings (Network Interface)

Default Settings (Al

Paper source

Master template

Location setting
Model MAC Address 1P Address Groups Model MAC Address 1P Address Groups
PX-M7030FX 64:EB:8C:CAD2:91 192.168.0.52 WF-R8390 Series A4EESTFREZAF 192.168.0.200 \Paris ¢
EP-07F Series AC:18:26:FB:60:78 192.168.0.55 \Paris ¢ WF-2630 Series AC1826:FB:80:43 192.168.0.60 \Paris ¢

S
PX-ME60F B4:EBBC25:41:C5 192.168.0.54 \Paris ¢
PX-1700F A4EESTAES21C 192.168.0.57
PX-M7050 Series A4EESTFRENTT 192.168.0.56
PX-MB50F BO:EB92FRESSC 192.168.0.58
WF-7620 Series A4EESTFRTOR 192.168.0.252 \Paris
WF-5690 Series A4EESTFRG2F3 192.168.0.100
1 ] 1 ]
[ mepy ] [ cance

n Select the devices to which the configuration template will be applied.

The devices to which the settings will be applied are in the Select Target list. To change these, move devices or
groups by using > ,>> , < ,and <<

Use > to move the selected device or group, and use >> to move all devices or groups.

Note:
d  When you select Devices and groups containing devices from the pull-down menu, each device is displayed.

1 Groupsaredisplayed when you select Groups. Select Include child group(s) to automatically select child groups
within the selected group.
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[ Aoy Configuration Template 1o Devices

Salect 8 confijuration tEmplate

Lecaton setting
Select Target
& Devices Al Devices
OIS Include chald groupds)

Selectable Device/Groud

MaaH [MAL Addciress P Addigss Groups
PR-MTOS0RK BATRACCAS2ET 192 168.0.52

EP-007F Saries AL B26:FRE0TE 192 168.0.55 \Parz
P-MB50F HAEROC:2541:C3 192168054 \Parie ¢
P 1700F BARESTLEREIC 192 168.0.57

PXAMTOS0 Saries BLEESTHFRELT] 192 168.0.56

P-MG50F B:ER-92FF 8550 1921680 58

WE-TH20 Series BAEESTFF 7081 192 166.0.252 \Pars ¢
WF-S600 Savrisg 192.168.0.7100

Click Apply.

O
Sefected Device/Group
Madel |MAC Addpess [P Address [Grosips
WF-RESH0 Series BAFESTFRELAF 1921660200 "WParis c
WF-2630 Series ACUE 26 FR:BIAT 92, 16E.0:60 "WParks
<
[ 0
Apply Cancel

A confirmation screen for the configuration template to be applied is displayed.

E Click OK.

A confirmation screen for the application results is displayed.

Check the content, and then click Close.

Apply 3 Configuration Template to Devices

Application result

Sucecessful

Failed

Unsupperted

1 Devices
0 Devices

0 Devices

You can check detailed information by clicking Details.

Editing configuration templates

You can change, duplicate, and delete a saved configuration template.

Select Configuration on the side bar task menu.

Select the configuration template you want to edit.
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Click Edit, Duplicate, or Delete on the ribbon menu.

@ Epson Device Admin - & X

[ Home | 2@
4 o1 = B =
E B ¥ 8

New  Saveas | Edit Duplicate Delete | Apply  Import Backup
Templats

Configuration Template

n Edit the configuration template.
You can perform the following actions for each item.

J  Edit

Change the setting values for the selected configuration template.

Click OK to save your edits.
4 Duplicate

Creates a copy of the selected configuration template.

Edit the configuration template name in the text box as necessary. Click OK to save the copied template.
4 Delete

Deletes the selected configuration template.

You cannot delete preset configuration templates. The selected configuration template is deleted when you click
OK on the confirmation screen.

Exporting and importing configuration templates

You can export and import a saved configuration template. You can use this for maintenance or backup. See the
following for details.

£ “Configuration templates” on page 118

Setting or changing devices one at a time

Device properties screen

Configure one device at a time by using the Device Properties screen.

Note:
You cannot configure the device while acquiring device information using the schedule function.

Select Devices on the side ber task menu.
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Click the Home tab on the ribbon menu.

Select the device you want to configure from the device list.

Note:
When you select multiple devices, you cannot configure them. If you want to configure more than one device, use the
Configuration Template or the Batch Setting function.

£ “Settings Template” on page 44

n Click Device Configuration.

The Device Properties screen is displayed.

B Epson Device Admin
Home View Groups a @
o O = — * [iP) Add Gl
= = B 2 Bowe o
All Selected Auto-Update Device [mbedded Web  Apply Configuration | Save as Configuration ~ Print Status. Discovery Check Options
Devices  Devices Configuration Server Template Template Sheet(s) Updates
Update Device Information Configuration Status Sheet Device List Firmware Options

When the password entry screen is displayed, enter the password, and then click OK.

Passweord x

Device Logon
Entter the current adminisirator password

IPasswnrd

OK Cancel

Set each item as necessary.

Set the device to match the environment being used. Displayed items differ depending on the model being
used.

See the following for the setting methods for each item.
£ Epson Device Admin Help "Device Properties"

E Click Transmit to set the necessary items.

Device Properties X
[=)- System Information ~ Method for Specifying IP Address
| Activation Information
- Quiet Mode Qs ®
) Network Interface [ Set using BODTP
& ‘”f"é’“““" ] Set using Automatic Private IP Addressing (APIPA)
..... 2sic
Administration Infor T
& Netwark
- Basic (Wired) P Address [ |
—Basic (Wireless) Subrel Mask: [ |
. Detailed (Wireless)
TP Defaull Gateway [ |
_Basic (Pv6} 1
i Basic (IPvE) 2
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Click OK.

Device Properties

- Collecting device data
- Printing, scanning, or faxing

- Making changes on the device's control panel
This process takes 10 seconds. Do you want to continue?

Cancel

'e Data may be lost or configuration change may not be reflected if you send information while:

X

When the password entry screen is displayed, enter the password, and then click OK.

Password

Device Logon

Enter the curent adminisirator passward

x

IPassworﬂ

0K

Cancel

Transmit the settings.

Note:

0 See the following when setting the password.

£ “Setting an Administrator Password” on page 55

0 The information is transmitted to the device, and then the message "Configuration successfully completed.” is
displayed. Do not turn off the device or the wireless adapter, and do not send any data to the device.

E Click OK.

Transmission is complete.

Current Progress

Corfiguration successfully completed

v I

E It can take up to three minutes until the settings are enabled. Do not turn off the device or wireless adapter

during this time.

The 4y icon is displayed in the device list while setting up the device.

[ Ifthe 4 icon remains after three minutes has passed, check the status of the device or the wireless

adapter.

(d  Ifthe!icon is displayed, communication with the IP address could not be completed. Check that the IP
address is enabled in the environment being used.

Using an embeded web server to make device settings

You can run Embeded Web Server (Web Config, EpsonNet Config (Web), or Remote Manager) when an IPv4 IP

address is set to allow unicast communication.

Select Devices on the side ber task menu.
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Click the Home tab on the ribbon menu.

Select the device you want to configure from the device list.

Note:

When you select multiple devices, you cannot configure them. If you want to configure more than one device, use the
Configuration Template or the Batch Setting function.

£ “Settings Template” on page 44

n Click Embedded Web Server.

The Embeded Web Server is displayed.

@ Epson Device Admin
Home View Groups ]
@ 9 I . : G, o &
= o 8 e [ O, e 0,
Al Selected  Auto-Update Device | Embedded Web | Apply Confiquration | Save as Configuration  Print Status  Discovery © Check Options
Devices  Devices Configuration Server Template Template Sheet(s) Updates
Update Device Information  nfiguration Status Sheet Device List Firmware Options
Note:

[ Ifyou cannot select Launch Browser, check that the IP address has been changed from its default setting, or that
the IP address is not already in use.

[ The message "There is a problem with this website’s security certificate.” may be displayed when running the
embeded web server. (The message varies depend on the browser.) This is displayed because the device uses SSL

communication (encrypted communication) to protect your personal information. Click "Continue to this
website (not recommended).”.

Set each item as necessary.

Set the device to match the environment being used. Displayed items differ depending on the model being
used.

Setting an Administrator Password

You can use an administrator password to protect device settings. The password is not set by default.

Setting individually
Configure one password at a time by using the Device Properties screen.

Select Devices on the side bar task menu.
Select the device you want to configure from the device list.

Ifthe device is not displayed, check that the device or wireless adapter is turned on, or if the device is in the same
segment as the computer.
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Click Device Configuration on the Home tab in the ribbon menu.

n Click Administrator Settings - Admin Password, and then enter the password in New Password and Reenter

New Password.

Device Properties

UPnP
IPP

SLP
Internet
W5D
LLTD
LLMNR

= M5 Netwaork

Basic
File
BirPrint
Basic
ShNMP
Basic
Access Control
Part Control
Timeout
Basic
Security
SSUTLS
Online Services
Epson Connect
Google Cloud Print

Scan

HNetwork Scan

= Administrator Settings

Administrator Name/Ce

Default Settings

Admiristrator Saitings

Administrator Pasyword

Click Transmit to set the necessary items.

[ Tensme | Cancel Helo

It can take up to three minutes until the settings are enabled. Do not turn off the device or wireless adapter

during this time.

Note:

The device administrator passwords are shared with each application used in network settings. Make sure you
manage the administrator password carefully.

Managing passwords in batches

You can save the password for devices in Epson Device Admin.

Managing passwords automatically

You can change settings without having to enter device's password the next time once an administrator password is
authenticated. Password information is saved to the data base of this software, and the software refers to the device's
MAC address after authentication.

You do need to enter the password when changing passwords of devices after saving password information. When the
revised password is authenticated, saved password information is updated.

Note:

This function is not accessible when batch settings or firmware update are in progress.
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Select Devices on the side bar task menu.

Click Options on the ribbon menu.

Select Password manager.

Select Enable automatic password management.

HENE

B options
Discovery Parameters Password manager
IP Address [j.;] Enable automatic passwnrd MANAREMENL i
IP Address Range
Network Address Use master password
Mad
Tiring Create & template lor importing password.

Formats

Alent Notifications
Configuration Template
Startup

Customize Ribbon
Password manager
Check for updates
System Administration
Backup/Restore

Click OK.

Setting a master password

Paszword manager

Create Template

Ok Cancel

If you set a master password, you need to enter the password when displaying the password list.

Creating a new master password

Set a new master password. Once it has been set, you need to enter the password if you change it.

Select Options - Password manager.
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Select Use master password.

The change master password screen is displayed.

Device Management

B options
Discoviry Parameters Pasgword manager
1P Address [+#] Enable automatic password management
IF Address Range
Mad
Timing Create a template for imparting password.
Formats

Alert Notifications
Configuration Template
Startup

Customize Ribbon
Password manager
Check for updates
System Administration

Backup/Restore

Enter the master password in New password and Confirm new password.

oK

Enter the password you want to set using up to 20 ASCII characters.

Password manager

Create Template

Change Master Password

Current password
New password

Confirm new password

[essnssed

0K ‘ ‘ Cancel

n Click OK.

Changing the master password

You need to enter the password to change the master password settings.

Note:

You also need to enter the password when you clear Use master password.

Select Options - Password manager.
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The change master password screen is displayed.

B ontions

Discovery Parameters
IP Address
IP Address Range
Netwark Address

Mad

Timing

Formats

Alent Notifications

Configuration Template

Startup
Customize Ribbon

Check for updates
System Administration
Backup/Restore

x
Password manager
(] Enabile automatic password managesmsent Pasgword manager
/] Use master password [ Change Master Password ]

Create a template for importing password.

Enter the current master password in Current password.

Change Master Password

Current password
New password

Confirm new password

oK

Create Template

Ok Cancel

n Enter the new master password in New password, and then enter the same password in Confirm new

password.

Enter the password you want to set using up to 20 ASCII characters.

Click OK.

Change Master Password

Current password
New password

Confirm new password

oK

Cancel

Editing an administrator password using the list

You can edit the administrator password for a device using the password management list.

See the following for details on backing up and restoring the password management list.

£ “Password settings” on page 111

Adding and editing a password

Add or change an administrator password.
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Select Options - Password manager.

Click Password manager.

The password management screen is displayed.

Note:
When a master password is set you need to enter the password.

B ontions b

Discovery Parameters Pagsword manager
IP Address (] Enable automatic password management I Password manager l
IP Address Range
Network Address [+f] Use master password [ Change Masier Password

Mad

Timing Create & template for importing password. [ Creane Tenplate

Formats

Alert Notifications.
Configuration Temglate
Startup

_Customize Ribbon

Check for updates.
System Administration
ackup/Rastore

Ok Cancel |

Click Add when setting a new password, and when changing settings select devices and then click Edit.

The add password screen is displayed.

Note:
You can change the group display for devices in Group.

[Pusswond manager
Group | All Devices

Model [MAC Address 1P Adidress Location Password

Ml wessom 00100:48: 5862181 10.8.196.34

& Le-ms1m0 B 4 128 10.8.156.18

] EW-MEEDFT Series 10.8.179.236

N PX-MT050FX 10.6.106.87

i Lm0 10.6.196.12

B ecMTosaR: 10815688

] PX-57070X 10.8.175.238 abedelghi]
W PX-1700F 10.6.196.236

] PX-MTOTORK P
B PX-M7050FX AEESTFREZES 10.8.197.79

[ Add Edit l Remove All Expon Impeat
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n When making new settings, enter the MAC address for the device.

When changing settings, the registered MAC address is displayed and cannot be edited.

Add password

MAC Address I ‘nonmaﬁ«cvas&l I

Password

Confirm new password

‘ oK [[ concet |

Enter any password in Password, and then enter the same password in Confirm new password.

Enter the password you want to set using up to 20 ASCII characters.

Add password

MAC Address 000048ACTB58

Password seseasse

Confirm new password ~ |[eseeeeen

‘ oK | [ Conenl

E Select the check-box next to the device that you want to manage.
Selected: Enables automatic authentication and password saving.

Cleared: Disables automatic authentication and password saving.

Pasgmed mandeper

Group | AN Devicss

Registering Different Address Books

You can import email addresses, target folders, abbreviated fax numbers from a product and edit the data.

Editing individually

See the following for the batch setting function.
£ “Making batch settings” on page 64

Note:
This function is only available for supported models.

Select Devices on the side bar task menu.
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Select the device you want to configure from the device list.

2

Click Device Configuration on the Home tab on the ribbon menu.

Click the item you want to edit from the following. Displayed items differ depending on the device being used.
Common - Contacts
Administrator Settings - Access Limitation
Scan - Mail Settings
Scan - Target Folder
Fax - Reception - FAX to Folder

Fax - Reception - E-Mail

DDDDDDDEM-

Fax - Fax Number

See the following for detailed information on each item.
5 Epson Device Admin Help "Device Properties”

Devies Propertiss x
Epson Connect [ Edit Contacts
Google Cloud Print
print/ c‘m;’ Display £ Delete Al
Printing Language
Paper Source Impot
User-Defined Paper Sou
Error Name:
=} Sean Browss
Metwork Scan : :
Fax
Transmit
Basic
Reception
Basic Byt
Fax output Export Rems: Al Rems v
Junk Fax Blacking Mems

Save to Inbox
Al the information about Contacts wil be exported

Report Set a password. The password is needed when you import the file

Line
Security

User Default Pasnword Seting
= Common
Email Server
Date/Time
Contrel Panel
External Interface
- Saing
Acminsuaos settings
ardministratnr Name/ e ¥
>
Cancel Hebb

Click Edit.

This step is unnecessary on the Administrator Settings - Access Limitation screen, Fax - Reception - FAX to
Folder/E-Mail screens, and Fax - Fax Number screen. Go to step 5.
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Select the number you want to edit, and then click Edit.

Device Properties X

[=)- Commeon ~ Address Book
Mail Server Settings
Scan
Basic Mymber Marme Indey Fnlder Dath Authenticatinn File & A
Mail Settings \\EpsonShared  V\EpsonShared  //\EpsonShared  EpsonShared  FTP
Target Folder
Network Interface
=) Information
- Basic

[1Do net display empty lines

03 Epson Epson \\EpsonShared Admin MS R

~ Administration Infor
=) Network

- Basic (Wired) o7

. Basic (Wireless) [ EpsonShared EpsonShared /M\EpsonShared\... EpsonShared FTP
09
10

06 \\Ep: d ps d IM\Ep EpsonShared FTP

Detailed (Wireless)
- TCP/IP
- Basic
Basic (IPvE) 1 Edit Delete Import Export
Basic (IPv6) 2
-~ DNS. Deletion of =l destination settings
- DNS (IPvE)
Bonjour
- IPP v

Delete Address List

==

7 Set each item, and then click OK.

Edit Target Folder

Nurber [0 ‘

Name [+\Epsonshared I

Index [+\Epsanshared |

File Sharing Method O WS Netwark (SMB) @FTP
Host Name [+\Epsanshared |

Folder Path

Authertication Name EpsonShared [ Anomymous

Auihertication Password [ |

Port Number [21 |

[ Use Passive Mode
1 OK || Cancel

If all settings are complete, click Transmit.

E When a confirmation screen is displayed, click OK to start transmitting the settings.

Device Properties X

'9 Data may be lost or configuration change may not be reflected if you send information while:
- Collecting device data
- Printing, scanning, or faxing
- Making changes on the device's control panel
This process takes 10 seconds. Do you want to continue?

Cancel

1 O Click OK to complete transmission.

Transmission is complete.

Corfiguration successfully completed

Current Progress

o I
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Making batch settings

Creating a settings file

You can save and edit information for the same item.
You can save information that includes security items such as private information by setting a password. You cannot

edit this file. See the following page for more details.
£ “Exporting by setting a password” on page 114

1

Select Devices on the side bar task menu.

Select the device you want to configure from the device list.

2

Click Device Configuration on the Home tab on the ribbon menu.

3

Click the item you want to edit. Displayed items differ depending on the device being used.
Common - Contacts
Administrator Settings - Access Limitation
Scan - Mail Settings
Scan - Target Folder

Fax - Reception - E-Mail

oo oy Py M E

Fax - Fax Number

See the following for detailed information on each item.
£ Epson Device Admin Help "Device Properties"

Select an export method.

If you select All Items, you need to set a password for the file. On Administrator Settings - Access Limitation
screen, when you click Export in the next step, you can then select an export format.

This step is unnecessary on the Scan - Mail Settings/Target Folder screens, Fax - Reception - FAX to Folder/
E-Mail screens, and Fax - Fax Number screen. Go to step 5.
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Click Export.

Screen for Contacts.

Device Properties X
Printing Language A Edit Contacts
Paper Source
User-Defined Paper Sou | = =X e
Error
- Scan mport
Network Scan
& Fax File Name:
- Transmit ‘ J ‘ Browse
i... Basic
(=- Reception Password
i Basic
.. Fax output Import...
Junk Fax Blocking
i Save to Inbox Export
R'eport Export items ltems except Security Information L
I:er:r'rty ltems except Security Information
User Default All the information except security information such as password will be exported.
ser Betau You can edt the exported file before you import.
=- Common If you want to export the security information, select "BExport All kems”.
Email Server
Date/Time
Control Panel
External Interface I | Export... I
Energy Saving
(- Administrator Settings
Administrator Name/Cc
Admin Password
Default Settings
v
< >
| Transmit | Cancel Help
7 Enter a file name, and then click Save.
. . . " "
A SYLK format file is saved with the extension ".slk".
B save As hed
« - T » This PC » Documents v O Search Documents y-l
Organize « Mew folder f== - o
~
# Quick access MName Date moedified Type
I Desktop + Mo iterns match your search.
& Downloads
Documents
[&=] Pictures »
b Music
B videos
f@ OneDrive
= ThisPC
. L 4 >
f
File ﬂame:l| AddessBook -
Save as type: | SYLK file (*.slk) ~

“ Hide Folders

Cancel
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E Open the SYLK file you saved in a spreadsheet application such as Microsoft Excel or in a text editor, and then
edit the information.

1 2 & 4 B 5] 7

1 'Number Mame Inclex 'Address 'Type 'IsGroup Grouplnde:s
2 '01 ABC Marke MI< '001 '2 ,0
g '02 ABC Sales 5L '002 '2 ,0
4 03 ABC DesigDS 003 2 o]
04 [ 1 1 [0
r LA
g6 05 -1 0

E Save the edited SYLK format file.

Reading the settings file

The software can read edited settings files.
See the following for details on binary files that include security items such as passwords and private information.

25 “Importing files containing security information” on page 116

Select Devices on the side bar task menu.

Select the device you want to configure from the device list.

Note:
To make multiple selections, press [Ctrl] or [Shift] and click your mouse.

Click Device Configuration on the Home tab on the ribbon menu.

3

Click the item you want to edit. Displayed items differ depending on the device being used.
Common - Contacts
Administrator Settings - Access Limitation
Scan - Mail Settings
Scan - Target Folder

Fax - Reception - E-Mail

[ T N N DE-

Fax - Fax Number

See the following for detailed information on each item.
£ Epson Device Admin Help "Device Properties"

Click Browse, and then select the file you want to import.

You need to enter the password when importing a binary file (.ene file).

On Administrator Settings - Access Limitation screen, Scan - Mail Settings/Target Folder screen, Fax -
Reception - FAX to Folder/E-Mail screens, and Fax - Fax Number screen, when you click Import in the next
step, you can then select a file.
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E Click Import.

Screen for Contacts.

Device Properties

- Printing Language A Edit Contacts
Paper Source

User-Defined Paper Sou

L. Error

=)- Scan Import

- Network Scan

- Fax

File Name:

Delete Al

(- Transmit ‘C:!Epson¥MdresaBook.ane

Basic

=) Reception Password:

Basic
Fax output I

Junk Fax Blocking
| Save to Inbox Export
- Report Bxport items: All ltems
~Line Al kems
i Security
| All the information about Contacts will be exported.

User Default Set a password. The password is needed when you import the file.
Common

i Email Server
Date/Time

i-. Control Panel

i External Interface
Energy Saving

:

[=)- Administrator Settings

i Administrator Name/Cc

i Admin Password

- Default Settings

Passwond: Setting...

=

When the "Start Import Wizard Confirmation” message is displayed, click OK.

Start Import Wizard Confirmation X

If data is imported, address data is
replaced with import data and current
changes are cancelled.

Do you want to continue?

- Cancel

E Check the information in Imported Information, and then click Import.

If you want to import multiple files, click Read more File.
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E Click Transmit.

Device Properties X

Printing Language ] Edit Contacts
- Paper Source
User-Defined Paper Sou
- Error
£ Scan Import
Network Scan
- Fax
| B Transmit ‘C‘¥Epsm¥Mdmsannk,me Browse...
Basic

Display... Edt.. Delete Al

File Name:

=- Reception

Basic
Fax output Import...
Junk Fax Blocking
Save to Inbox Bxport

Report Export ftems: Al lems v

-Line Al hems
Security
All the information about Contacts will be exported

i User Default Set a password. The passwond is needed when you import the file
- Common

Password:

Email Server
Date/Time
Control Panel
External Interface Export...
.. Energy Saving
= Administrator Settings
Administrator Name/Cc
Admin Password
Default Settings

Password: Setting....

| - -

When a confirmation screen is displayed, click OK to start transmitting the settings.

Device Properties *

Data may be lost or configuration change may not be reflected if you send information while:

- Collecting device data

- Printing, scanning, or faxing

- Making changes on the device's control panel

This process takes 10 seconds. Do you want to continue?

Cancel
Click OK to complete transmission.
Transmission is complete.,
Configuration successfully completed.
Current Progress
v N
0K I

Updating Device Firmware

You can check for the latest firmware and then update the device's firmware if necessary.

Updating firmware

Check the firmware version site for the device, and update the firmware if necessary. Updates can only be performed
for devices that support the features registered to the device list.
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Before updating you need to make settings to allow access to external sites.

£ “Check for updates” on page 29.

Select Devices on the side bar task menu.

Click the Home tab on the ribbon menu.

Select Check Updates.

Access external site to check for updates.

)] Epson Device Admin - & X
Home View Groups 7 ]
S Qo - ;] = — hd add  eUndo | @

= c) = E i ®O‘

3 Delete

Al Selected | Auto-Update Device  Embedded Web  Apply Configuration  Save as Canfiguration  Print Status  Discovery
Devices  Devices Configuration Server Template Template Sheet(s)

Updates

Update Device Information Configuration Status Sheet Device List

Display in the device list when firmware is updated.

n Select devices in the device list to update firmware.

Click Update.

Firmware is updated.

Note:
If Enable Update button in Options - Check for updates is not selected, firmware version is not checked.

Firmware Update Schedule

When you create firmware update schedules for devices, the firmware is automatically updated at the date and time
you specified. You can update multiple devices at the same time.

Creating a Firmware Update Schedule

Create a firmware update schedule to specify the device that you want to update and the update date and time.

Select Devices on the side bar task menu.

Click the Home tab on the ribbon menu.
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Click Update.

The Firmware updates screen is displayed.

5] Epson Device Admin -
Home iew Groups
* 5
L T - c) H = Gy o O [
= Y= " @ ) i ML g o|®| &
elete
A Selected | Auto-Update Device  Embedded Web | Apply Configuration | Save 3s Configuration  Print Status  Discovery | Edit Check | Update | Options
Devices  Devices Configuration Server Template Template Sheetis) Updates
Update Device Inf Configuration Status Sheet Drevice List Firmware Cystions

Note:
If Enable Update button in Options - Check for updates is not selected, Update is unavailable.

n Click New.

The firmware update schedule creation Wizard is displayed.

[B) update Firmware - O X
Schedule name Device num... |Update start date an... |Status |
Edit
Delete

View Status

Close

Check Cautions on updating firmware, and then click Next.

E Update Firmware X

Cautions on updating firmware
Cautions

- It is highly recommended to set a firmware update schedule outside of the working hours.

- The target devices and the computers in which Epson Device Admin or Epson Device USB Agent is installed must be turned on
at the scheduled time.

- For printers, make sure that there is no print waiting job.

- Do not use the devices until the update is completed.

- The update may take up to 15 minutes per device. It cannot be canceled.

- The display on the device screen may disappear or turn blue, but wait without touching it.

- If the device is used with a battery, connect the power cable.
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E Specify where the firmware is stored.

E Update Firmware X

Select firmware

Select firmware

® Load fram Epson server

O Load from PC

Cancel | ‘ Back oK

4 Load from Epson server
Updates by downloading the latest version firmware from the Epson server.

d Load from PC
Updates using the firmware file that you specified.

Click Next.

E Select the devices with firmware that you want to update.
You can select the group to which devices are registered from the select group menu.

Target devices are listed in the box on the right. To change these, move devicesbyusing > ,>> , < ,and
<<
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You can move selected devices by using > , < ,and all devices by using >> , <<

E Update Firmware
Select devices
Target devices
| All Devices b |
Select devices to add to the update list.
Model |pNs Name |ma - [Model DNS Name [ma -
WF-6590 Series Lo EW-M660FT Series EPSONGCEBAE o4 |
PX-MT7050FX Adl PX-M7070FX EPSONEDY 1% “al
PX-M7050FX A4l LX-10000F pilaka apo epron net Al
WF-M5690 Series ~
WF-R8590 Series 1601190 apo epu Adl
LP-M8170 41
WF-3520 Series L
AL-M320DN s
PX-1700F A4l
PX-M5040F Adl
WF-C869R Series 441
PX-M7070FX 4l
PX-M7050FX A4l
WF-4720 Series _
‘ ] ‘ [r]
‘ Cancel ‘ ‘ Back | | Next | | oK |

E Click Next.

The firmware is downloaded.
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1 O Check the download result for each device in Status, and then click Next.

@ Update Firmware X

Firmware

Firmware Information

Model DNS Name Previous Version Updated Version Status IP Addre
EW-MB60FT Series EPSONGCEBAE 5F.DD29G6 60.DD10H2 Loaded W17
PX-M7070FX EPSONE 2E54.HR25H1 No update d
LX-10000F Polsia spo spsone  2B.68.GA28H2 No update 3

‘ Cancel | | Back | I Next I OK

1 1 Check the license agreements of the firmware for each device, select I agree with the license agreement, and
then click Next.

ﬂ Update Firmware X

License agreement

EW-M660FT Series

SEIKO EPSON CORPORATION
SOFTWARE LICENSE AGREEMENT

IMPORTANT! READ THIS SOFTWARE LICENSE AGREEMENT CAREFULLY. The computer software product, fontware, typefaces
and/or data, including any accompanying explanatory written materials (the "Software”) should only be installed or used by the
Licensee ("you") on the condition you agree with SEIKO EPSON CORPORATION ("EPSON") to the terms and conditions set forth
in this Agreement. By installing or using the Software, you are representing to agree all the terms and conditions set forth in
this Agreement. You should read this Agreement carefully before installing or using the Software. If you do not agree with the
terms and conditions of this Agreement, you are not permitted to install or use the Software.

1. License. EPSON and its suppliers grant you a personal, nonexclusive, royalty-free, non-sublicensable limited license to install
and use the Software on any single computer or computers that you intend to use directly or via network. You may allow other
users of the computers connected to the network to use the Software, provided that you (a) ensure that all such users agree
and are bound by the terms and conditions of this Agreement, (b) ensure that all such users use the Software only in
conjunction with the computers and in relation to the network of which they form part, and (c) indemnify and keep whole
EPSON and its suppliers against all damages, losses, costs, expenses and liabilities which EPSON or its suppliers may incur as a
consequence of such users failing to observe and perform the terms and conditions of this Agreement. You may also make
copies of the Software as necessary for backup and archival purposes, provided that the copyright notice is reproduced in its
entirety on the backup copy. The term "Software” shall include the software components, media, all copies made by you and
any upgrades, modified versions, updates, additions and copies of the Software licensed to you by EPSON or its suppliers.
EPSON and its suppliers reserve all rights not granted herein.

2.0ther Rights and Limitations. You agree not to maodify, adapt or translate the Software. You also agree not to attempt to
reverse engineer, decompile, disassemble or otherwise attempt to discover the source code of the Software. You may not
share, rent, lease, encumber, sublicense or lend the Software. You may, however, transfer all your rights to use the Software to
another person or legal entity provided that you transfer this Agreement, the Software, including all copies, updates and prior
versions, to such person or entity, and that you retain no copies, including copies stored on a computer. Some states or E

| agree with the license agreement I

Cancel | ‘ Back | Next oK
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E Update Firmware

Update Schedule

Schedule name

New Schedule

Update start date and time

® Set the schedule start date
2017/03/07 EI 0:00 EZI

O Start immediately

Note

While updating the firmware, data collection of the device may not be performed.

Device information collection time

Device Usage 13:00
Supply Usage 13:00
Accessory Inventory 13:00
Hourly Peak Usage Every hour on the hour

Cancel | ‘ Back Next

See the following to make the setting.

Item

Explanation

Schedule name

Enter the name for the firmware update schedule (up to 255 characters in Unicode
without control characters).

Update start date and time

Sets when the schedule starts.

[  Setthe schedule start date
Sets the date and time to start the schedule. You can set the time in minute.

1 Startimmediately
Click OK to save the schedule and start updating.

Click OK.

The firmware update schedule is created and saved.

When Start immediately is selected for Update start date and time, the firmware update starts.

Editing firmware update schedules

You can change and delete firmware update schedules.

Select Devices on the side bar task menu.

Click the Home tab on the ribbon menu.
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Click Update.

Firmware updates screen is displayed.

Note:
If Enable Update button in Options - Check for updates is not selected, Update is unavailable.

n Select the schedule that you want to edit, and then make settings using the screen displayed.

E Update Firmware - O X
Schedule name Device num... |Update start date an... [Status ‘ New
iSales div. 3 2017/03/13 18:00 Scheduled ]

Design div. 1 2017/03/14 1:00 Scheduled Edit

Marketing div. 1 2017/03/15 0:00 Scheduled

Delete

View Status

|

Close

d Change: Edit
The firmware update schedule Wizard is displayed. Change the settings using the Wizard.
[  Delete: Delete

Displays the delete confirmation screen. To delete the schedule, click Yes.

Checking the Status of Firmware Update Schedules

You can check the status of the firmware update schedule for each device.

Select Devices on the side bar task menu.

Click the Home tab on the ribbon menu.

Click Update.

Firmware updates screen is displayed.

Note:
If Enable Update button in Options - Check for updates is not selected, Update is unavailable.
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n Select the firmware update schedule that the device you want to check the status is regisred, and then click View
Status.

View Status screen is displayed.

E Update Firmware - O X
Schedule name Device num... |Update start date an... [Status ‘ New
| Sales div. 3 2017/03/13 18:00 Scheduled

Design div. 1 2017/03/14 1:00 Scheduled Edit

Marketing div. 1 2017/03/15 0:00 Scheduled
| View Status

[

Close

Check the information displayed in the device list.
The following information is displayed.

Name

MAC Address

IP Address

Serial Number

Before update

After update

o 0o o0 o0 o0 o o

Status

E Click OK to close the screen.
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Daily Management

This chapter explains how to make preparations for daily management.

When you have set schedules for acquiring device information and alert notifications, this software collects device
information and monitors devices automatically, and then sends you a notification if a problem occurs.

By making report settings, since this software collects device data for specified periods, you can check the frequency
the device is used and the status of consumables.

Managing the Device List

Collecting information regularly

You can update device information regularly by using Auto Refresh.

Schedule settings

Set the time interval for regularly collecting information.

Select Devices on the side bar task menu.
Click Options on the Home tab on the ribbon menu.
Click Timing.

Set the interval to collect information.

HEANER

B options ®
Discovery Parameters Data Collection Time
IF Address | Device Usage 1300 & =]

1P Address Ra s
P Address Range +f| Supplies Usage 1300 ==
Network Address £ i}

| Accessonies Inventory 1200 =]

r a
Formats

¥ Hourly Peak Usage

Data retention penod
Alert Notifications e

D Da 2] Yea
Configuration Temglate evices Lata ear
Startup Generated reparts 2] Year
Customize Ribbon
Fassword manager Log retention period
Check for updates Logs 0 Day
System Administration Update Device Information
B [Rastos
Gackup/Restore ® Refresh interval o0 =)=

Select the day of the week Mendzy Tuesday Wednesday Thursday
Friday Saturday Sunday

Festore Default Settings

oK Cancel
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(d  Refresh interval

Collects device information at regular intervals after starting Auto Update.

You can set the interval in units of one minute from 1 minute to 23 hours 59 minutes.
[ Select the day of the week

Collects device information on a specified day and time.

You can specify Monday through Sunday, and the time in minutes.

Click OK.

Starting Auto Update

Start Auto Update.

Select Devices on the side bar task menu.

Click Auto-Update on the Home tab on the ribbon menu.

Auto Refresh is started.

Note:
You can cancel data collection using a schedule by clicking the 3 icon at the bottom-right of the screen. The schedule
settings are canceled at the same time.

Displaying the device list settings
You can customize the display for the device list.
The following customizations are available.
4 Display presets
Frequently used presets are provided by default.
You can also save the current display as a preset.
4 Edit columns
You can edit columns, and display only those columns you need.
d Filtering

You can filter target devices by filtering the column displayed using a character string.
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Display presets
a Epson Device Admin - A x
home [ v ]| Groups ~@
B & K 1E

Default  Supplies Counts Add as Edit Edit
Preset  Preset Column

Presets Edit

You can switch the display by using the menu on the View tab on the ribbon menu on device management screen.

Icon Explanation
Basic View Displays the default presets.
Default, Default settings view. Displays consumables and the number of prints.
Supplies,
Counts
User Defined Displays registered preset in a pull-down menu.
Registering a preset

You can register the items for the current device list as a preset. You can register up to 256 items.

Select Devices on the side bar task menu.
Convert the display of the device list to the display registered as preset.

Click Add as Preset on the View tab on the ribbon menu.

@ Epson Device Admin - 0 x

Home View Groups o @
[ +

= ses
B 4 K - E W
Default Supplies Counts Add as Edit Edit
Preset || Preset Column

Presets Edit

n Enter the name of the preset, and then click OK.

Enter up to 255 characters in Unicode.

B Add a Preset - [} X

l Preset| . ]

Note:
You can select the name of an existing preset, and overwrite the settings by clicking OK on the confirmation screen.

Editing presets

You can change or delete the name of a registered preset or set the default preset.
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Select Devices on the side bar task menu.

Click Edit Preset on the View tab on the ribbon menu.

)] Epson Device Admin - 0 x

Home View Groups @
Y +

= P

B ¢ K - E| m
Default Supplies Counts Add as Edit Edit
Preset Preset Column

Presets Edit

Use the buttons to change the preset settings.

B Edit Preset - m] ®

Basic View

LFP View

Preset

OK | | Cancel

See the following to make the settings.

Item Explanation
Definition view list Displays user-defined presets. The default preset is displayed in bold.
A,V Moves the selected preset to up or down the list.
Change Name Changes the name of the selected preset.
Delete Deletes the selected preset.
Set as Default Sets the selected preset as the default. This is assigned to the Default button on the
ribbon menu.

n Click OK.

Editing columns

You can change the way columns are displayed in the device list.

Select Devices on the side bar task menu.
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Click Edit Column on the View tab on the ribbon menu.

Epson Device Admin - B x

Home View Groups o @

B 6 K == T

Default Supplies Counts Add as Edit Edit

Preset  Preset Column
Presets Edit

Use the buttons to change the preset settings.

The item Selected column(s) is displayed in the device list.

You can add the amount of remaining consumables, the number of times consumables have been replaced, and
the number and type of printed pages (A4, A3, Color, B&W).

B £ Column - o x

Awailable solumns Selected columeds)

Yelkw Ink L

Vellow Ink/Taner Replacements

el

oK Cancel

ITYZZet;zctual display items may differ depending on the device being used.
[ The number of prints contains paper jams, print mistakes, and status sheets.
0 Depending on the timing for data collection, there may be errors in the total number of prints.
0 The amount of ink remaining and replacement times are displayed in Gray for Dark Gray and in Light Gray for
Light Gray depending on the device being used.
0 The remaining amount of consumables is approximate.
0 For ink injection devices, the amount of ink remaining and the ink replacement times are displayed as numbers
when performing operations as explained in the manual.
1 Ink and toner with the same color are displayed in the same item.
1 Ink for devices with sets of two colors that are the same is displayed as (C1) and (C2).
Item Explanation
Category Select the category for basic information and consumables for items displayed in
Available Column.
, < Moves the selected item to the column on the left or right.
, VvV Moves the position the item is displayed up or down the list.
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n Click OK.

Using filters

By entering keywords in the Apply Filter text box on the ribbon menu, you can display devices containing the same
character string in the device list.

Enter up to 255 characters in Unicode. The software does not distinguish between upper and lower case characters.

To cancel the filter, delete the character string from the text box.

B Epson Device Admin - B0 x
Home View Groups ] e
e + , ——
B 4 K - B
Default Supplies Counts Addas  Edit Edit
Preset Preset  Column
Presets Edit
4 (@ Default Groups Search Filter |Wﬂ ‘ “ General -
B All Devices (10) Toae! TVIAC Aoaress [iF Agaress TSt JCast Upas Manufacturer EPSON
P i Meodel 5
i New Devices (0} I Series 182.168.0.200 & Error 1/28/201¢ o e
i Configured Devices (0) Series 192.1680.60 Idle status 1/28/201¢ DNS Name
B Ungrouped Devices (3) Series 162,1680252 0 Inklow. (Cyan) ~ 1/28/201¢ MAC Address
£ Warning Devices 2 e 192.168.0.100 dle status 1/28/201¢ IP Address 182.168.0.200
B Error Devices (3) Serial Number 25E9000004
i Unresponsive Devices (0) Last Update 1/28/2016 81421 AM
4 [ User Defined Groups Last Update (UTC) 1/28/2016 4:14:21 PM
4 [ Paris office (2) (3) Memory 1536
i Sales and Marketing div. Duplexer Installed
B New York office (0} Front Paper Feed Slot  Installed
e e g

Managing Alerts

You can monitor alerts from devices and send notifications to set email addresses depending on the type of alert.

To use the alert feature, set the type of alert and the email recipient, and then connect it to the group of devices to be
monitored.

Note:
Use this feature when selecting features during software installation. If it is not already installed, you can set it from
the Windows Control Panel. See the following for details.

5 “Changing features and uninstalling” on page 13

Creating alerts

You can create alerts based on the alert type and email address.

You can create it up to 10,000 items.

Select Alerts on the side bar task menu.
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Click New on the ribbon menu.

a
Pl a
Mew | Edit Duplicate Delete

Alert Management

Enter the items.

.
Daily Management
Epson Device Admin - B x
& @
B create Mew Alert O ®
Alert Name Supply leved low
Alert Type Supplies level low -

To ITadmmine supply@epson.com

Select from History

Subject Alert from Epson Device Admin
Message Supply level low alert.
Motification email resend interval Lse Detault
Add/Remaove groups Ok Cancel

See the following to make the settings.

Item Explanation

Alert Name The name of the alert displayed on the alert list. Enter up to 1,024 characters in Unicode.

Alert Type Set the conditions for sending an alert notification. You can select from the following.
1 Paperjam
d  Paperout
[ Supplies level low
[  Supplies level warning
1  Service call problem
1 Cover open (For printers only)

To Enter the email address to which alert notifications are sent.
When entering multiple addresses, separate the addresses with semi-colons (;). You can
enter up to 32,767 bytes including [;]. Enter all addresses in the [TO] field. You cannot use
the [CC] or [BCC] fields.
You can select and insert multiple addresses that you have entered previously by clicking
[Select from history].

Subject The subject of the alert notification email. You can enter up to 256 characters.

Message The text of the alert notification email. You can enter up to 64K bytes.
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Item Explanation

Default Notification E-mail Select the time until the next time the alert notification email is sent if the alert has not
Retransmission Interval of been cleared on the device.

the Same Alert Select from following.

Use Default, 5 minutes, 10 minutes, 30 minutes, 1 hour, 3 hours, 6 hours, 12 hours, 1 day, 2
days, 3 days, 4 days, 5 days, 1 week

When selecting Use Default, the time set in Default Notification E-mail
Retransmission Interval of the Same Alert in Options - Alert Notifications is applied.

n Click OK to save the alert and close the screen. Click Assign/Remove Group(s) to set monitored groups using
the created alert.

When you click OK, the alert is created and added to the alert list.

When you click Assign/Remove Group(s), you can add groups to be monitored by alerts. See the following for
details.

Adding groups monitored by alerts

You can set monitored groups with the created alert. This sends notifications when an alert is generated on a device in
the group.

Select Alerts on the side bar task menu.

Selects alert from the alert list.

You cannot add monitoring groups when selecting multiple templates.

Click Assign/Remove Group(s) on the ribbon menu.

@ Epson Device Admin - 0 x
= =@
o ogP

New  Edit Duplicate Delete [ Assi

Alert Management
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n Select the group you want to monitor, and then click > to move it to Subscribed Group(s).

When you move a group to Unsubscribed group(s) by clicking <

B Add/Remove groups - m} X
Unsubscribed group(s) Subscribed Groupls)
‘\London office "\Paris office
‘\Paris office\Sales and Meketing div.

Click OK.

Alert monitoring for devices in the selected group begins.

, alert monitoring is canceled.

Note:

You can set multiple alerts for one group. Add the alerts to each monitoring group.

Setting the alert confirmation interval

You can set the interval to check alerts from the device.

Select Devices on the side bar task menu.

Click Options on the Home tab on the ribbon menu.

@ Epson Device Admin

Home View

Q

Groups

All Auto-Update
Devices

Update Device Information Configuration

@o Eadd e Unde
),
Discovery
Firmware

Status Sheet Device List

Select Alert Notifications.
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n Set the interval to check for alerts.
B opvions X
Discovery Parameters General
P Address Interval to check for alerts [1-800] ) Second(s)
P Address Range
Default Motification E-mail Retransmission Interval of the Same Alert 2 houre

HNetwork Address
Mail
Timing
Formats
Alert Notifications
Configuration Template
Startup
Customize Ribbon
Password manager
Check for updates
System Admmistration
Backup/Restore

Scanner

L] Netify when the number of paper jams per day exceeds the specified number

Restore Default Settings

OK Cancel

See the following to make the settings.

Item

Explanation

Interval to check for alerts
[1-600]

Set the interval to check for alerts on devices.

Enter 1 to 600 seconds in intervals of 1 second.

Notification email resend
interval

Sets the time to resend a notification email that an alert has occurred if the alert is not
cleared from a device.

Select from the following.

5 minutes/10 minutes/30 minutes/1 hour/3 hours/6 hours/12 hours/1 day/2 days/3 days/4
days/5 days/1 week

Notify when the number of
paper jams per day
exceeds the specified
number

Sendsa notification when the number of paperjams on the scannerin one day (from 0:00 to
23:59) is the same as the specified number.

Number of occurrences

Sends a notification if the set number of paper jams that occurs in one day exceeds the
specified number of times. Enter 1 to 99 times in intervals of 1.

Editing alerts

You can change, duplicate, and delete alerts you created.

Select Alerts on the side bar task menu.

Select an alert from the alert list.

You can only select multiple alerts when deleting.

86




Epson Device Admin User Guide Win

Daily Management

Set using the screen displayed when you click the button on the ribbon menu.

@ Epson Device Admin
Home
(+] (] —
Pl | &
New | Edit Duplicate Delete | Assign/Remove
Groupls)

Alert Management Subscribe

4 Change: Edit

Displays the alert screen. Change the settings, and then click OK.
1 Copy : Duplicate

Displays the alert name screen. Enter a new name, and then click OK.
A Delete : Delete

Displays the delete confirmation screen. To delete the alert, click OK.

- 0 x

- @

Switching the alert display

You can switch the alert list and the log screen when clicking the item in the tree view.

The number next to the item name is the number of alerts in the item.

a8

oA P

New Edit  Duplicate Delete

Alerts

4 B Nerts

M Subscribed Alerts (2)
A Unsubscribed Alerts (0)
HilLogs (0]

Alert list

Displays a list of alerts at the top.
Displays content for the selected alert and the monitored device group at the bottom.
0 Al
Displays all alerts.
[d  Subscribed Alerts
Displays alerts that have been subscribed to at least one group.
(d  Unsubscribed Alerts

Displays alerts that have not been subscribed to any groups.
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Log

When you select Logs from the tree view, a log of alert notifications are displayed at the top, and detailed content is
displayed at the bottom.

You can set the time to save logs in Log retention period from Options - Timing.

Report Management

Report management allows you to output the status of devices, consumables, and accessories as a report.

You can create reports by using the Wizard.

Note:
0 Use this feature when selecting features during software installation. If it is not already installed, you can set it
from the Windows Control Panel. See the following for details.

5 “Changing features and uninstalling” on page 13

O If your computer is set to daylight saving time, errors may be generated during data collection and timed
intervals for reports.

Creating reports

You can create reports for target device groups using the conditions for the selected report format. You can create the
report by specifying a period or setting a regular schedule. Create device groups before creating reports.

£ “Group Management” on page 34

Select Reports on the side bar task menu.

Select User Defined Report - Scheduled reports from the tree view.

@
Home

E= = I

New  Edit Duplicate Delete

eport Management

4 = Database

ser ort
Scheduled reports(1

b Archived Repartsi(2)

Click New on the ribbon menu.

The report creation Wizard is displayed.

B8 Epson Device Admin - 0 x
o] ~@
el @ &
New | Edit  Duplicate Delete

eport Management Export Database
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n Set conditions when acquiring report data.
Select from the following.

Device Usage / Hourly peak usage / Supply Usage / Accessory Inventory

[B) Create New Report / Schedule b

Select a Report Type
Report Type

Data Type

Device Usage

Device Usage

©

| Hourly peak usage
Supplies Usage

Accessories Inventory

Select the conditions used to create a report by specifying the period or setting a schedule.
Create report by specifying a period: Clear the Create a Schedule check box.

Create report by setting the schedule: Select the Create a Schedule check box.

E Click Next.

Select the target device group.

Target groups are listed in the box on the right. To change these, move groupsbyusing > ,>> , < ,and
<< .

You can move selected groups by using > , < ,and all groups by using >> , << .
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Select Include child group(s) to automatically select child groups within the selected group.

(B Create New Report / Schedule »

Select Groups
Target Groups

Select groups to add in the report format

Group name Devices Group name Devices
Paris affice 1 [ \Paris office\Sales div. 1
‘London office [

7] Include chitd groupds)

E Click Next.

E Specify the report format.

(B Create New Report / Schedule *

Specify Report Format
Report Format

Primary sort Model ¥ | Ascending order

Secondary sort None - | Ascending order

Device Information
Select items to add in the report format

Manufacturer - [ 53 || Model

DONS Name | MAC Address
Serial Number g 1P Address
Epson Open Platform

Firmware version

Connechion <<

Data Column

Select items to add in the report format
1-Sided Pages - T 53 || Total Pages
2-Sided Pages .| Mono Pages
1-Sided Mono Pages 8 Color Pages
1-Sided Color Pages
2-Sided Mono Pages
2-Sided Color Pages

coneel [ [ sack |1 New

See the following to make the settings.

Item Explanation

Primary sort Select the key given first priority when sorting reports using device information items.

Secondary sort Select the key given second priority when sorting reports using device information items.
Available items are the same as for Primary sort.
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Item Explanation
Device Information Select the device information items to be included in the report.
Data Column Select the collection data to be included in the report. See the following table for the
available items.

Available items for collection conditions
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Item

Explanation

Device Usage (Printer)

You can select information for compatible paper sizes.

1 Total print pages:
The total number of pages printed from the time you start using the printerare tracked
by the printer engine. This numberis not only tracked during the reportrange, but also
in periods out of the report range.
1 Total pages:
The total number of pages printed are tracked by the printer engine.
(4 Mono pages:
The total number of black-and-white pages printed are tracked by the printer engine.
1 Color pages:
The total number of color pages printed are tracked by the printer engine.
1  1-sided pages:
The total number of simplex pages printed are tracked by the printer engine.
1 2-sided pages:
The total number of duplex pages printed are tracked by the printer engine.
4 1-sided mono pages:
The total number of simplex black-and-white pages printed are tracked by the printer
engine.
1 1-sided color pages:
The total number of simplex color pages printed are tracked by the printer engine
[  2-sided mono pages:
The total number of duplex black-and-white pages printed are tracked by the printer
engine.
d  2-sided color pages:
The total number of duplex color pages printed are tracked by the printer engine.
d  Total Prints (m):
The total printed length is calculated by the printer engine (m).
d  Total Prints (m2):
The total printed area is calculated by the printer engine (m2).
d  Pages by Function (Printer)/Pages by Function (Copy)/Pages by Function (Fax)/Pages
by Function (Other):
The total number of pages printed is tracked by the printer engine for each function.
[  Mono Pages by Function (Print)/Mono Pages by Function (Copy)/Mono Pages by
Function (Fax)/Mono Pages by Function (Others):
The total number of black-and-white pages printed is tracked by the printer engine for
each function.
d  Color Pages by Function (Print)/Color Pages by Function (Copy)/Color Pages by
Function (Fax)/Color Pages by Function (Others):
The total number of color pages printed is tracked by the printer engine for each
function.
Note:

The total page count in the report may differ from the actual total page count due to the
timing for data collection.
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Item

Explanation

Device Usage (Scanner)

You can select information for compatible paper sizes.
[ Total Scan Sheets/Total Scan Pages:

The total number of sheets/pages scanned are tracked by the scanner engine.
[ Mono Total Scan Sheets/Mono Total Scan Pages:

The total number of black-and-white pages scanned are tracked by the scanner
engine.

d  Color Total Scan Sheets/Color Total Scan Pages:

The total number of color pages scanned are tracked by the scanner engine.
(d 1-Sided Total Scan Sheets/1-Sided Total Scan Pages:

The total number of simplex pages scanned are tracked by the scanner engine.
d  2-Sided Total Scan Sheets/2-Sided Total Scan Pages:

The total number of duplex pages scanned are tracked by the scanner engine.

(J  ADF Total Scan Sheets/ADF Total Scan Pages:

The total number of sheets/pages scanned using the ADF are tracked by the scanner

engine.

(1 ADF Mono Total Scan Sheets/ADF Mono Total Scan Pages:

The total number of black-and-white sheets/pages scanned using the ADF are tracked

by the scanner engine.
(1 ADF Color Total Scan Sheets/ADF Color Total Scan Pages:

The total number of color sheets/pages scanned using the ADF are tracked by the
scanner engine.

(d ADF 1-Sided Total Scan Sheets/ADF 1-Sided Total Scan Pages:

The total number of simplex sheets/pages scanned using the ADF are tracked by the

scanner engine.

(d  ADF 2-Sided Total Scan Sheets/ADF 2-Sided Total Scan Pages:

The total number of duplex sheets/pages scanned using the ADF are tracked by the

scanner engine.
J  FBTotal Scan Sheets/FB Total Scan Pages:

The total number of sheets/pages scanned on the FB are tracked by the scanner
engine.

J  FB Mono Total Scan Sheets/FB Mono Total Scan Pages:

The total number of black-and-white sheets/pages scanned on the FB are tracked by

the scanner engine.

(1 FB Color Total Scan Sheets/FB Color Total Scan Pages:

The total number of color sheets/pages scanned on the FB are tracked by the scanner

engine.

Note:

The total page count in the report may differ from the actual total page count due to the

timing for data collection.

Hourly peak usage

You can select the same items as in Device Usage.

Supply Usage

Displays the amount remaining and the replacement times for the ink/toner.
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Item Explanation

Accessory Inventory Memory
Duplexer
Paper Source

FAX

IR R R

The following shows the compatible paper sizes for Device Usage.

ul
A4 Letter A4/Letter
A3 Ledger A3/Ledger
A4 Letter Ad/Letter
A5 A5 A5
A6 A6 A6
B4 Legal B4/Legal
B5 B5 B5
other other other
Click Next.
Specify the report range.

The display may differ depending on the data collection conditions that you selected in step 4.

When you have selected Device Usage, Supply Usage, or Accessory Inventory:

[ Create New Report / Schedule %

Specify the Date Range for Report Generation
Date Range
Report Interval

Per Week

Date Range

From 1 Week ¥ ago

To ® Generated date

Report Per Week from 1 Week ago to Generated date

Concel || Bak || Nen oK

See the following to make the settings.

94



Epson Device Admin User Guide Win

Daily Management
Item Explanation

Report interval Select the interval for creating reports from the following.
(A Per Day
d  Per Week
d Per2Weeks
4 Per Month
(d  PerQuarter
(4 Per Year

Date range Specify the report range from the date the report was created or by specifying a
date on the calendar. Specify by using a combination of any number over 1and a
day/week/month/year.

When you have selected Hourly peak usage:

[B) Create Mew Report / Schedule x

Specify the Date Range for Report Generation
Interval of Repart Generation
Date Range

From 1 Day © ago
To ®) Generated date

Time Range

Allday
From 9:00

To 17:00

Report Hourly Peak Usage from 1 Day ago to Generated date

Cancel ‘ ‘ Back ‘ ‘ Next oK

See the following to make the settings.

Item Explanation

Date range Specify the report range from the date the report was created or by specifying a
date on the calendar. Specify by using a combination of any number over 1 and a
day/week/month/year.

Time range Sets the target period of a report.

When setting 24 hours, select All day. When specifying a time, set the start and
end times.

Note:
If the report range contains a period before Epson Device Admin was installed, the information for that period is
blank in the report.

Click Next.
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Specify Destinations

Naotification Type

Type
Archive only ® Email and archive
ﬁ ITadmmn+d Eepson.com; gerBepson.com
Select from History
Subject Report from Epson Device Admin
File format & PDF HIML 5V
Cancel |1 Back | MNext
See the following to make the settings.
Item Explanation
Type Specify whether or not to send a notification email.
To Enter the address to which the alerts are sent.
When entering multiple addresses, separate the addresses with semi-colons (;).
You can enter up to 32,767 bytes including [;]. Enter all addresses in the [TO] field.
You cannot use the [CC] or [BCC] fields.
Subject The subject of the alert notification email. You can enter up to 256 characters.
File format Sets the file format. You can select from PDF, HTML, or CSV.

Click Next.
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Specify a report name.

Name of the report to be output. Enter up to 1,024 characters in Unicode.Enter report name

@ Create a report

Specify Report Name

Report name

Enter a report name.

Device Usage

Cancel || Back || Nest oK

Click Next.
Specify a schedule.

Note:
A Ifyou clear the Create a Schedule check box in step 5, this screen is not displayed.

0 Set the Start date and time for the Creation Schedule after the data collection time. If this is set to before the data
collection time, the report is created before starting data collection on the last day in the report range.

5 “Setting the data collection time” on page 100

[B) Create New Report / Schedule

Specify Schedule
Creation Schedule
Start date and time
1/28/2016 m;anl
End date

@ None O End at [

Report Creation Cycle

Report Creation Cycle

Every Week - Monday

Creating a report is scheduled for Every Week Monday 10:02 after 1/28/2016.

concel || Bak [ mext oK
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See the following to make the settings.

Item

Explanation

Start date and time

Set the a day to start the schedule. The units are intervals of one minute.

End date

Set the day to end the schedule.

Select None if you do not want to specify an end day.

Report Creation Cycle

Specify the interval for creating reports.

Click Next.
Click OK.

The report or schedule is created.

The created report is saved as an archive report.

[B) Create New Report / Schedule X

Confirmation

Data Type
Groups

Device Usage
\Paris office\Paris office\Sales and Marketing div.\New York office;

\Lenden office
Report Format
File format PDF
Primary sort Model
Primary sort Ascending order True
Secondary sort None
False
Model:MAC AddressiP Address

Total Pages:Mono Pages:Color Pages

Secondary sort Ascending order
Device Information
Data Column

Date Range
Report Interval

From

Per Week
1 Week ago
To Generated date
Email
Type
To
Subject
Scheduled Reports
Start date and time
End date
Report Creation Cycle

Archive only
Report from Epson Device Admin
1/28/2016 10:02 AM

None
Every Week Monday

[ o |

Configuration Examples for Report Creation

See the following examples to create a report for a fixed range.

Device Usage/Supplies Usage/Accessories Inventory

1 Creating weekly reports for the last three months every month

Specify the Date Range for Report Generation

Report Interval: Weekly
Date Range: Last 3 Month
Specify Schedule

Report Creation Cycle: Every Month
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4 Creating monthly reports for the last six months every month

Specify the Date Range for Report Generation
Report Interval: Monthly

Date Range: Last 6 Month

Specify Schedule

Report Creation Cycle: Every Month

[d  Creating quarterly reports for the last year every quarter

Specify the Date Range for Report Generation
Report Interval: Every 3 months

Date Range: Last 1 Year

Specify Schedule

Report Creation Cycle: Every Quarter

Hourly Peak Usage
4 Creating daily reports every day

Specify the Date Range for Report Generation
Date Range: Last 1 Day

Specify Schedule

Report Creation Cycle: Every Day

[ Creating a weekly report every week

Specify the Date Range for Report Generation
Date Range: Last 1 Week

Specify Schedule

Report Creation Cycle: Every Week

Acquiring data

You can collect data for devices based on the selected data types. Acquired data is used for reports. You can set the
collection start time conditions. See the following for details.

£ “Setting the data collection time” on page 100

Select Reports on the side bar task menu.

Select Database - Data Collection from the tree view.

4 B User Defined Report
Bl Scheduled reports(2)
B Archived Reparts(3)
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Select the collection conditions from the data collection conditions list.

You cannot select multiple collection conditions.

n Click Collect Now on the ribbon menu.

B8 Epson Device Admin - 0 x
o ] > @
14
=
=
Collect
Now
Report Management Export Database

Setting the data collection time and saving period

You can set how long collected data is saved from the option menu on the device management screen.

Setting the data collection time

You can set the collection time depending on the device data collection conditions.

Select Devices on the side bar task menu.

Click Options on the Home tab on the ribbon menu.

)] Epson Device Admin - @ X
Home View Groups 7 ]
Q_ @O Add ey Undo

= )
All Auto-Update Discovery Options
Devices
Update Device Information Configuration Status Sheet Device List Firmware Options

Select Data Collection Time, and then set the start time to acquire data for each condition.

Select Timing.

You can set from 0:00 to 23:59 in minutes.

B options ®
Discovery Parameters Data Collection Time
1P Address 7] Device Usage 1o E=
1P A s 3 r — .
P Address Range V| Supplies Usage 1300 [E[*
Network Address y
Ml 7] Accessenies Inventory ]
[] Houty Peak Usage
Formats o p
ata retention al
Alert Notifications: L
Devices Data 3| ear
Configuration Template £
Startup Generated reports 2| vear
Customize Ritibon
Password manager Log retention period
Check for updates Logs 30| Day
System Administration Update Device Information
ac R
Backup/Restore ) Refresh interval oo B>
Select the day of the week Monday Tuesday Wednesday Thursday
Fricay Saturday Sunday
Restore Default Settings
O Cancel
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See the following to make the settings.
Item Explanation
Device Usage The time to start collecting data based on the device usage conditions.
Supplies Usage The time to start collecting data based on the consumable usage conditions.
Accessories Inventory The time to start collecting data based on the accessory installation conditions.
Hourly Peak Usage Select this to set the time to start collecting data for reports.

Setting the data saving period

You can set the period for saving collected data and reports.

Select Options - Timing.

Set Data retention period.

B options ®
Discovery Paramaters Data Callection Time
IP Address ¥ Device Usage 1300 & =]
1P A Rax -
P Adaress Range /| Supplies Usage 1300 =
Network Address
| Accessaries Inventory 1wE"
| Hourly Peak Usage
onmats
) ention penod
Alet Notifications Data retention periog
Devices Data 2 Year

Configuration Temgplate

Startup Generated reports
Customize Ribbon

a
&

Password manager

Check for updates 30 Cay
5}‘5‘9"\ Administration Upda'.e Device Information
Backup/Rastore ® Refresh interval o100 B~
Select the day of the week Mendzy Tuesday Wednesday Thursday
Friday Saturday Sunday

Festore Default Settings

oK Cancel

4 Devices Data

Sets the period for saving collected data.

You can set the period from 1 to 5 in years. Data for which the saving period has expired is automatically deleted.
[ Generated reports

Set the saving period for reports saved in the archives.

You can set the period from 1 to 5 in years. Data for which the saving period has expired is automatically deleted.

Click OK.
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Switching the report display

When you click items in the tree view, you can switch the report management display.

The number of report formats and archived reports is displayed under User Defined Report.

2]
Fome

Report Management

Databaze

= Data Collection

4 B User Defined Report
Bl Scheduled reports(2)
B Archived Reparts(3)

Collecting data

Information on collecting data is displayed in Database - Data Collection in the tree view.

4 Conditions for collecting data
The list of data types is displayed at the top.
You can set the Data Collection Times from the Options screen. See the following for details.
£ “Setting the data collection time” on page 100

4 Device list

The device list for collecting data and the device status is displayed at the bottom.

Data Type | Description |Pata Collection Times |
Device Usage Report the number of prints 13:00

Hourly peak usage Report the number of prints per hour s

Supplies Usage Reports the ink/toner level of the devices. 13:00

|Accessories Inventary Report the accessories installed on the device 13:00

Data Type: Hourly peak usage

Status Madel IP Address Serial Number Groups First Collection Date  [Last Collection Date
Successful WF-R8590 Series 192.168.0.200 25E9000004 \Paris office\Sales an... 1/28/20169:00 AM  1/28/2016 9:00 AM
Successful PX-M7050FX 192.168.0.52 UTEY010674 1/28/2016 9:00 AM  1/28/2016 9:00 AM
Successful EP-907F Series 192.168.0.55 \Paris office\Sales an... 1/28/2016 9:00 AM  1/28/2016 9:00 AM
Successful PX-MS60F 192.168.0.54 4CES000003 \Paris office\Sales an... 1/28/2016 9:00 AM  1/28/2016 9:00 AM
Successful WF-2630 Series 192.168.0.60 TWE9101042 \Paris office 1/28/2016 9:00 AM  1/28/2016 %:00 AM
Successful PX-1700F 192.168.0.57 1/28/2016 9:00 AM  1/28/2016 %:00 AM
Successful PX-M7050 Series 192.168.0.56 1BES000046 1/28/2016 %:00 AM  1/28/2016 %:00 AM
Successful PX-MB50F 192.168.0.58 20E9000051 1/28/2016 9:00 AM  1/28/2016 %:00 AM
Successful WF-7620 Series 192.168.0.252 10E9000108 \Paris office 1/28/2016 9:00 AM  1/28/2016 %:00 AM
Successful WF-5690 Series 192.168.0.100 19G9300005 1/28/2016 9:00 AM  1/28/2016 %00 AM

User defined reports

Displays the information on report management in User Defined Report in the tree view.
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Schedule
Displays the report format and the list of schedules when you select User Defined Report - Scheduled reports.

When you select a schedule from the list at the top, the content is displayed at the bottom.

Report Name ‘Data Type |Lasl Creation Date |Nex‘t scheduled date and...
Device Usage Device Usage 19/10/2016 15:11

:De'\rice Usage Device Usage 19/10/2016 15:28

Device Usage Device Usage

4 »

Report Name: Device Usage

Data Type Device Usage -
Groups \Paris office
Report Format
Primary sort Model
Primary sort Ascending order True
Secondary sort None
Secondary sort Ascending order False
Device Information Model;MAC Address;|P Address
Data Column Total Pages;Mono Pages;Color Pages
Date Range
Report Interval Per Week
From 1 Month ago
To Generated date
Email
Type Archive only
To
Subject Report from Epson Device Admin -

Archive report
Displays the list of archived reports when you select User Defined Report - Archived Reports.

When you select a report, the content of the report is displayed.

Report Name | ate Created |poF HTML csv
iDevice Usage - weekly 19/10/2016 14:32 v v v
‘Device Usage 19/10/2016 15:11 v " v
Device Usage - weekly 19/10/2016 15:25 v v v

T 9

Report Name: Device Usage - weekly

EPSON

Report Type Device Usage

Generated Date 18/10/2016 14:32:36

Grouping Criteria Paris office, Sales div., London office
Sorting Criteria Model (Primary sort), None (Secondary sort)
Date Range 20/09/2016 - 19/10/2016

Report interval Per Week

Group: Paris office

Date Range m MAC Address IP Address Total P

2NINAMINAAR _ 2RINAMN1A ED 077A? Qarine RA-ER-Q-N2-RC-RN 107 1RQ 12 2

Sending archived reports by email

You can send archived reports by email.
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Select Reports on the side bar task menu.

Select User Defined Report - Archived Reports from the tree view.

@
Home
(]
5]
Delete

Report Management

4 = Database
= Data Collection
4 [ User Defined Report
B Shadiled ranartcl)

Archived Reports(3)]

Select the report you want to send by e-mail from the report list.

Note:

To make multiple selections, press Ctrl or Shift and click your mouse.

n Click Email on the ribbon menu.

The email settings screen is displayed.

)] Epson Device Admin - 0 x
Home @
Q +
8 |&|&
Delete Email Save
Report Management Export Database
Set each item.
B emsil - O x
To
Subject
File format (®) PDF O csv O HTML
See the following to make the settings.
Item Explanation
To Enter the email address to which you want to send a report.
When entering multiple addresses, separate the addresses with semi-colons (;).
You can enter up to 32,767 bytes including [;].
Enter all addresses in the [TO] field. You cannot use the [CC] or [BCC] fields.
Subject The subject of the report email. You can enter up to 256 characters.
File format Sets the file format for the report. You can select PDF, HTML, or CSV.
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E Click OK.

The set content is sent by e-mail.

Saving and deleting archived reports

You can save and delete an archived report.

Select Reports on the side bar task menu.

Select User Defined Report - Archived Reports from the tree view.

Home
]
£

Report Management

4 = Database
= Data Collection
4 Bl User Defined Report
B Shadiled ranartcl)

Select the report you want to save or delete from the report list.

You can only select multiple reports when deleting.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.

n Click the edit button on the ribbon menu, and then make save settings or confirm that you want to delete the
report depending on the screen displayed.

B Epson Device Admin - B x

Home =@

B & &

Delete Email Save

Report Management Export Database

[ Save: Save the archived report(s)

The save settings screen is displayed. [Report Template Name + Report Create Day] is set as the file name. You
can change this if necessary.

Select the file format and the location to save the file, and then click OK.
4 Delete: Delete the archived report(s)

The delete confirmation screen is displayed. To delete the file, click OK.
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Printing a Status Sheet

When the devices in your network are printers, you can check detailed information on the devices by printing a status
sheet.

You can send printing commands to multiple selected devices.

Select Devices on the side bar task menu.

Select a device (printer) to print a status sheet from the device list.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.

Click Print Status Sheet(s) on the Home tab on the ribbon menu.

@ Epson Device Admin - & X
Home View Groups o @
0 O = — + £ 4dd A Und 5

m G = P] % 2 o B

Embedded Web  Apply Configuration | Save as Configuration | Print Status | Discovery
Server Template Template Sheetfs)

Configuration Status Sheet| Device List

All Selected Auto-Update
i

n Click OK.

A status sheet is printed from the printer you selected.

Backing up and Restoring

You can backup and restore system settings. This allows you to prepare for a system failure, as well as add devices or
replace devices.

Items that can be backed up and restored
The following items can be backed up and restored.
4 System settings
You can save and restore system settings and all Epson Device Admin data to a backup file.

£ “System settings” on page 107
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d  Device list
You can save and restore the device list to which devices were added to a backup file.
£ “Device list” on page 109
1 Password list
You can save and restore the password list managed by Epson Device Admin to a backup file.
£ “Password settings” on page 111
d  Address book
You can save and restore address book information such as addresses and fax numbers to a backup file.
25 “Address books” on page 114
d Configuration template
You can save and restore configuration templates to a backup file.
5 “Configuration templates” on page 118
4 Device settings
You can save and restore configuration values for devices to a backup file.

£ “Backing up device settings” on page 141

System settings

You can save the database file containing Option menu settings such as Notification email settings, Discovery
conditions, and External site access settings, as well as Alert and Formats settings in .zip file format.

Backing up system settings

Note:
0 Depending on the size of the database, it may take a while to backup the data.

1 You cannot backup and restore when the firmware update schedule is running.

Select Devices on the side bar task menu.

Click Options on the Home tab on the ribbon menu.

Click Backup/Restore.
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n Click Backup.
Options. x
@
Discovery Parsmeters Backup application settings
IP Address. Device communication and data collection will be stopped during the backup process
1P Address Range
MNetwork Address 1
Mad l Backup l

Timing
Formats

Alert Notificabions Restore application settings
Configuration Template Current device data and information will be replaced. Device communication and data collection will be stopped during the

restoee process
Startup F

Customize Ribban
Password manages Restare
Check for updates

Systemn Administration

oK Cancel

Click Browse, specify the destination to save the backup file, and then click OK.

E When you want to set the password, select Use Password, and then enter the password.

Enter the password you want to set using up to 20 ASCII characters.

Click OK.

The backup file is saved to the specified destination.

Restoring system settings

Select Devices on the side bar task menu.

Click Options on the Home tab on the ribbon menu.

Click Backup/Restore.
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n Click Restore.
B options ®
Discovery Parameters Backup application settings
IF Address Device communication and data collection will be stopped duning the backup process

IP Address Range
Network Address

. Backup

Tirning
Formats

Alert Notifications Restore application settings

Configuration Template Current device data and infarmation will be replaced. Device communication and data collection will b stopped during the

Startup FeSTaNE process

Customize Ribbon I
Password manager

Restore ]

oK Cancel

Select the saved backup file, and then click OK.

E When a password is set for the file, enter the password, and then click OK.

Click OK.

Restoring is started.

Device list

You can save and read the information on the device list for the device management screen in a device information

file.

Note:
0 [Reset], [Open], and [Save] buttons are displayed on the ribbon menu on the device list management screen
when [Show Reset, Open, and Save buttons in the Device List] is selected from [Option] - [Detailed Settings].

£ “Operation Settings” on page 23
1  Group setting information is not saved when saving the device list.
Group setting information is saved when you backup the system settings.

£ “System settings” on page 107

The following are the device information files.
[ Device list file (PLF format)

This is an XML file containing the method for specifying IP addresses and MAC addresses for the device list.
[  Device list file (TXT format)

This is a TXT file containing IP addresses separated by line breaks.
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[  Device data file (PRDF format)

This is an XML file containing device list file information added when collecting device information. This is
encrypted for security.

Saving a device information file

Select Devices on the side bar task menu.

Click the Home tab on the ribbon menu.

Click Device List group - Save.

(& Epson Device Admin - & X
Home View Groups Y]
Q. 9 ;] ® — _ + [iF) B Reset (3 Add [
= = G 1= [=1=) '—_~‘/ E O- =t Open - [J Delete Q o
Al Selected | Auto-Update Device Batch Embedded Web | Apply Configuration | Save as Configuration  Print Status  Discovery e Check Options
Devices Devices Configuration  Settings Server Template Template Sheet(s) Updates
Update Device Information Configuration Status Sheet Device List Firmware Options
n Select the file format and save destination.
@ save b3
« v M [E » ThisPC » Documents v | @ | Search Documents p
Organize = New folder = -
~ O This PC " MName - Date modified Type
[ Desktop Mo items match your search.
> |4 Documents
4 Downloads
D Music
=] Pictures
B Videos
. Local Disk (C)
¥ Network
v < >
File name | -
—
Save as type:  DEVICE LISLTHELPH) () =
' Hide Folders Cancel
Click Save.
Reading a device information file
. .
Select Devices on the side bar task menu.
Click the Home tab on the ribbon menu.
Click Device List group - Open.
B Epson Device Admin - & X
Home View Groups o @
o 9o c) ;] ;2] = = + G- B Reset 3 Add &
m = E B e Q, 8 Deete O o
All Selected = Auto-Update Device Batch Embedded Web  Apply Configuration  Save as Configuration  Print Status  Discovery (& P Check Options
Devices Devices Configuration Settings Server Template Template Sheetis) Gy Dave Updates
Update Device Information Configuration Status Sheet Device List Firmware Options
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n Select the information handling method for the file you want to read.

5] Epson Device Admin - & X
Home View Groups o @
Q. O G = :] ::] = ) + ] () B Resst [8 Add il

= 8 =8 R v O, =0 O,
A A i . R . . i Open~ EJ Delete oh o
Al Selected | Auto-Update Device Batch Embedded Web | Apply Configuration  Save as Configuration  Print Status  Discavery Check Option
Devices  Devices Configuration ~ Settings  Server Template Template Sheet(s) e Updates
Update Device Information Configuration Status Sheet Add to device list Firmware Options

Select the device information file, and then click Open.

When reading the device list file (PLF format/TXT format), only information for MAC addresses and IP
addresses is displayed. To display other information, update the device information.

When reading the device data file (PRDF format), the read-only Logs group is added to the first layer of the tree
view. Information on the device is displayed here. When you read the device data file again, the Logs group is

replaced with new information.

@ open %
€« v 4 [ » ThisPC > Documents v | @] | Search Documents )
Organize + New folder =~ O @

# Quick access Name Date modified Type
#@& OneDrive No items match your search.
~ I ThisPC
[ Desktop
> || Documents
& Downloads
D Music
&) Pictures
B videos
‘i Local Disk (C3)
¥ Network < >
File namel‘ V‘I Device List File(.plf) (*.plf) -

Password settings

You can backup and restore an administrator's password for devices using the password management list.
See the following for details on adding and editing passwords.

£ “Adding and editing a password” on page 59

Backing up passwords

Select Devices on the side bar task menu.

Click Options on the ribbon menu.

Select Password manager.
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n Click Password manager.

The password management screen is displayed.

B options =

Discovery Parameters Password manager
IF Address | Enable automatic passward management [ | Password manager ] ]
1P Addlress Range
Netwerk Address [ Use master password Change Master Passward

Mail

Timing Create a template for importing password, | Create Template

Formais

Alert Notifications
Configuration Template
Startup

Customize Ribbon

System Administration
Backup/Festore

Click Export.

The password backup screen is displayed.

Paspword manages

Group | All Devices

[ MAC Address P Addeess |Location
[+ 192.1680.200

I 192.168.0.52

= 192.1680.55

o 192168054

=~ UL GR0ED

cd A EESTALAZ: 192168057

B PX-MTOS0 Senes. MARESTFRENTY 192168056

[ PX-MESOF BO-EBSFRESSC 192.168.0.58

S

7620 Seres MAESTFFTOR 192.168.0.252

[ Diepilay passwerdis)

Add | | £t Femcve All I| Eepart ‘l Inpart |
; — )

E Click Browse to select the destination to save the backup file.

Export password(s) ‘
Output path Reference
Password

Confirm new password

Enter a password in Password, and then enter the same password in Confirm new password.

Enter the password you want to set using up to 20 ASCII characters.

E Click OK.
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Select Devices on the side bar task menu.

Click Options on the ribbon menu.

Select Password manager.

n Click Password manager.

The password management screen is displayed.

B ontions
Discovery Parameters Password manager
IP Address [¥] Enable automatic password management Il Password manager
1P Address Range
Network Address. :I Use master password Change Master Password
Mad
Tirning Create 3 template for importing passwerd. | Create Template
Formats
Alent Notifications
Configuration Template
Srartup
Customize Ribbon
Check for updates
System Administration
Backup/Restors
oK | Cancel
Click Import.
The password restore screen is displayed.
Paspword manager
Group | All Devices v
[ [Meaat MAC Address | Address |Location -
[ WF-RE550 Series ALEESTFRELAF 192.168.0.200
[ PR-MTOSORY 192.160.0.52
[ EP-SOTF Serses TLIGE05S
¥ Pa-Mas0F 192168054
] WF-2630 Sers UL GR0ED
[ Px-1700F 192168057
B FX-MTOS0 Senes 19L1680.56
1 P-MESOF 192168058
[ WF-T620 Series 192168.0.252 -
[ Dieplay passwondis)
Add | | it Pasncve All | Expart I| Impart I
Clorse
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E Click Browse to select the backup file.

When overwriting current device passwords, select Overwrite an existing password.

Import passwerd(s)

File path [ \l Reference l

Ovenwrite an existing password

Password

oK Cancel

Enter the password you set for the backup file in Password.

Enter the password you want to set using up to 20 ASCII characters.

E Click OK.

Address books

You can export and import address books to a file by setting a password.

Note:
This function is only available for supported models.

Exporting by setting a password

See the following for details on exporting items except for security information such as passwords and private
information.

£ “Registering Different Address Books” on page 61

Select Devices on the side bar task menu.

Select the device from which you want to export the address book from the device list.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.

Click [Change Setting] on the [Home] tab on the ribbon menu.

n Click the item for which you want to edit contact details from the following. Displayed items differ depending
on the device being used.

1 Common - Contacts
(4 Administrator Settings - Access Limitation

[ Scan - Mail Settings
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4 Scan - Target Folder

4 Fax - Reception - E-Mail

d Fax - Fax Number

Click Export.

Screen for Contacts.

Maintenance

See the following for detailed information on each item.
& Epson Device Admin Help "Device Properties"

Device Properties

Printing Language
-- Paper Source
User-Defined Paper Sou
Error
- Scan
| Network Scan
(= Fax
=} Transmit
Basic
- Reception
Basic
Fax output
Junk Fax Blocking
Save to Inbox
Report
Line
Security
-- User Default
(=- Common
Email Server
Date/Time
- Control Panel
External Interface
Energy Saving
(= Administrator Settings
Administrator Name/Cc
-- Admin Password
Default Settings

~

Edit Contacts
Display... Edit Delete All
Import
File Name:
Browse
Import
Bport
BExport items: ltems except Security Information
ltems except Security Information

All the information except security information such as password will be exported.
You can edt the exported file before you import.
If you want to export the security information, select "Export All ltems”.

=

E Select Export with Security Information, and then click OK to set a password.

Select Export type

Select Export type
(O Nomal Export

Set Password
Password:

Reenter New Password:

If you select [Export with Security Information]. you have to set a password.
The password will be required when you import the file.
Take care when handling export files that contain security information.

1 0K

|I Cancel

Enter a file name, and then click Save.

An encrypted ENE format binary file is saved. You cannot edit this file.
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When importing this file, a password is required.

B save As X
+ |§] » This PC » Documents v | D Search Documents yal

Organize » Mew folder == o

# OQuick access ol MName Date modified Type
I Desktop

& Downloads
|‘:_:‘] Documents

Mo iterns match your search.

% % W %

&=/ Pictures
Jﬂ Music
m Videos

f@ OneDrive

[ This PC
L 4 >

Fileﬂame:|| AddressBooH V‘I

Save as type: | Binary file (*.ene) ~

“ Hide Folders Cancel

Importing files containing security information

See the following for details on exporting items except for security information such as passwords and private
information.

£ “Reading the settings file” on page 66

Select Devices on the side bar task menu.

Select the device for which you want to import an address book from the device list.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.

Click the item you want to edit from E-Mail, FAX to Folder, or Fax Number. Displayed items differ depending

Click Device Configuration on the Home tab on the ribbon menu.
n on the device being used.
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Click Import.

Screen for Contacts

Device Properties X

i Printing Language ~ Edit Contacts
. Paper Source

User-Defined Paper Sou
L. Error

(- Scan import
H Network Scan

Display.. Edt.. Delete Al

- Fax File Name:

= Transmit ‘C'&’Epaon!Mdraand(,ans J Browse...
Basic

=3 Reception Password: J

- Basic
Fax output I Impott... l
- Junk Fax Blocking
Save to Inbox Export
~ Report Export items: All kems v
p-Line Al hems
Security
All the information about Contacts will be exported

User Default Set a password. The password is needed when you import the file.
- Common

Email Server
i Date/Time
‘.. Control Panel
External Interface Export...
i Energy Saving
= Administrator Settings
i~ Administrator Name/Cc
- Admin Password
Default Settings

Password: Setting....

[ -

E When the "Start Import Wizard Confirmation” message is displayed, click OK.

Start Import Wizard Confirmation X

@ If data is imported, address data is
vy replaced with import data and current
changes are cancelled.
Do you want to continue?

- Ca nce'

Set the path to the file you want to import, and then click Next.

Click Browse, and then select the binary file (*.ene) containing information such as email addresses or user
information for the Access Limitation function, and then click Open. You need to enter the password set when
the file was exported to open a binary file.

Select Import File
Select Import File
I|C:\Users\epson\Documents\AddressBock.ene Browse... l
« Back MNet > Cancel
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E Click Transmit.

Device Properties

i Printing Language ~ Edit Contacts
.. Paper Source

User-Defined Paper Sou
L. Error

[=)- Scan import
Network Scan

Display. . Edit. Delete Al

- Fax File Name:

& Transmit ‘C‘!’Epson!Mdraanuk,ms I Browse...
Basic

=- Reception Password:

Basic
- Fax output Import...
- Junk Fax Blocking
Save to Inbox Eport
i~ Report Export items: All kems
Line Al kems
Security
{ All the information about Contacts will be exported.

- User Default Set 3 password. The password is needed when you import the file
Common

.- Email Server

i Date/Time
Control Panel

i External Interface Export...

i Energy Saving

= Administrator Settings

- Administrator Name/Cc

- Admin Password

i Default Settings

Password: Setting...

Cancel

E When a confirmation screen is displayed, click OK to start transmitting the settings.

Device Properties *
[ Data may be lost or configuration change may not be reflected if you send information while:
k. v

- Collecting device data

- Printing, scanning, or faxing

- Making changes on the device's control panel

This process takes 10 seconds. Do you want to continue?

Cancel
Click OK to complete transmission.
Transmission is complete.
Corfiguration successfully completed.
Current Progress
v N

Configuration templates

You can save and restore configuration templates to a file.

Saving configuration templates

Select Configuration on the side bar task menu.
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Select a configuration template to backup from the template list.

You cannot select preset configuration templates.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.

Click Backup on the ribbon menu.

@ Epson Device Admin - & X
o] X
[+] + [x} 3
il 2 #|8
New Saveas  Edit Duplicate Delete  Apply  Import [Backup
Template

Configuration Template

n Select the destination to save the file and enter a file name

@ savers x
€« v 4 [ » ThisPC » Documents «|® | Search Documents )

Organize v New folder e @

A Name Date modified Type

~ [ This PC

[ Desktop Neo itemns match your search,
> 5] Documents

¥ Downloads

b Music

&= Pictures

[ videos

e Local Disk (C3)

=¥ Network

File name | ~

Save as type: | Lonfiguration Iemplatefile (. 13E] ~

© tide Foldes Concel

Click Save.

TSE format template files are saved together in a Zip file.

Reading configuration templates

Unzip the Zip file containing configuration templates and retrieve the configuration template files (TSE format).

Select Configuration on the side bar task menu.

Click Import on the ribbon menu.

The file import screen is displayed.

@ Epson Device Admin - @ X

] =@
[+] + [ -

o1 =) &

New  Saveas  Edit Duplicate Delete  Apply [import [Backup

Template
Configuration Template

Select the configuration template file (TSE format) to be imported.
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n Click Open.

The configuration template is imported and the results are displayed.

Click OK.
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Troubleshooting

Troubleshooting for Epson Device Admin.

Cannot discover devices.

Assign an IP address to the devices, and then specify the IP address manually.

For devices that are connected to computers on the network by USB cables, install the Epson Device USB Agent on the
computers and search for them by using the computer's IP address.

Cannot changethe networkinterface, orcannotuseitonthenetwork.

Solution 1)
Check if you can print a network status sheet.
If you can print the sheet, check the network settings printed on the network status sheet.

Solution 2)
Check ifhubs and LAN cables are working correctly. For hubs, check if the link lights for the ports where the devices
are connected are flashing or lit.

Check the following if the link light is off.
(4 Connect the hub to a different port.
(d Connect to a different hub.

(d Replace the LAN cable.

If you still cannot communicate after trying all of the above, the network interface may not be working. See the device
manual for details.

Solution 3)

Check if the IP address is valid.

The default IP addressis "192.168.192.168". However, you cannot use this address on the network. Change the address
according to your environment.

Solution 4)

Check if Keep blocking, Cancel, or Block is selected on the "Windows Security Alert" screen or in your commercially
available security software.

Communication cannot be performed if one of these is selected. To enable communication, register this application as
an exception in the Windows firewall or your commercially available security software.

Some commercially available security software still may not allow communication. In this situation, close the security
software while using this application. When you have finished using this application, restart your security software.
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You do not know the IP address.

Solution 1)
If you want to use the DHCP function on the router (DHCP Server, or Wi-Fi router), set the device to automatically
acquire the IP address.

Solution 2)
To set up the IP address and subnet mask manually, see the following.

1. Check the IP address of the router (DHCP Server, or Wi-Fi router) that is connected to your computer. See the
router’s manual for details on checking the IP address.

2. For IPv4, the IP address is composed of four segments of numbers. From the first to the third segment of the
numbers, set the same number as the router. Set a unique number between 1 to 254 for the fourth segment.

Example:

If the router's IP address is 192.168.1.1

Set the device to 192.168.1.3

Set 255.255.255.0 as the subnet mask if you are on a small network. Set the same number for all devices in the network.
If the gateway can be configured, use the same IP address as the router. Note that you cannot use the address
192.168.192.168 on the network.

The message "The network connectionisinvalid or not set. Check the
network settings." is displayed when running Epson Device Admin.

This message is displayed in the following situations.

(4 When TCP/IP is not built-in to the computer.

(4 When the computer’s IP address is incorrect.

(4 When there is no DHCP server and the Epson Device Admin is set to acquire an address from the DHCP server.

Check the computer status, built-in TCP/IP, and set the IP address.

Not Ready is displayed as the IP address on the device list.

Solution 1)

You can set up a network interface even if IP address is not displayed. In this case, MAC address is used to specify the
device. You can check the MAC address by printing a status sheet or from the printer's control panel. See the product’s
documentation for details.

The IP address is displayed correctly when a network interface is configured.

Solution 2)
Go to Devices - Options. Set the discovery conditions, and then click Discovery.
£ “Discovery condition settings” on page 31

Solution 3)

Go to Options - Startup. Set the Discovering and rebooting timeout (10-180) to alarger value. However, discovering
may take some time when a large value is set.

£ “Operation Settings” on page 23
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IP address changes on its own.

Solution 1)
Set the Method for Specifying IP Address to Manual on the Basic - TCP/IP screen, and then manually enter the IP
address.

Solution 2)
If you want to set the Method for Specifying IP Address to Automatic and your DHCP server does not support
dynamic DNS, make sure you turn on the devices in the same order every time or keep them turned on.

Devices from other companies are not displayed in the device list, or
they are displayed but not enough device information has been
acquired.

The SNMP protocol is used to acquire device information in Epson Device Admin.

If you want to discover devices from other companies and acquire their information in Epson Device Admin, they
need to support the SNMP protocol and be compliant with MIB IT (RFC 1213), HostResource MIB (RFC1514), and
Printer MIB (RFC 1759).

Epson Device Admin acquires the device information using these MIBs. If devices from other companies cannot
respond to these MIBs, their information cannot be acquired.

Also, the volume of information acquired from devices from other companies may be less than the information
acquired from the Epson device.
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Secondary Device Management Method

SYLK is a secondary method for managing devices and their settings.

Assigning IP address

Epson Device Admin can recognize the Epson devices on the network even when IP addresses have not been assigned.
Follow the steps below to assign an IP address.

Connect devices to the network using an Ethernet cable.

Discover the devices.

Set the necessary discovery range.

£ “Discovering devices” on page 30

Use the filter feature on the device list to unfilter devices by [IP address].

=

£5° “Using filters” on page 82
Save a SYLK file for making settings.

£ “Create a file outlining the settings” on page 130

Enter IP addresses in the network settings columns in the SYLK file, and then save the file.

Set IP addresses for the devices using the batch settings feature.

Bl B

£5° “Batch Settings” on page 125

Checking for overlapping items

When managing multiple devices, conflicts may occur when replacing devices for settings that are assigned unique
values for each device, such as IP addresses.

You can check for overlapping items when reading a SYLK file for device settings. Follow the steps below to find
overlapping IP addresses.

Select devices in each group, or select all devices, to confirm conflict items from the device list.
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Save a SYLK file for making settings.

£ “Create a file outlining the settings” on page 130
Apply all SYLK files.

£ “Assigning information automatically” on page 125

n When there are items that conflict, the following screen is displayed.

Check the message displayed.

Batch Settings *
I 1 Setting items that should be unigue to each device are duplicated in the file.
= Edit the setting infformation to avoid duplication.

1.Info_CommenDevice
DeviceMame,
DeviceName,

2 TCPIP_IPAddress
192.168.0.151,
192.168.0.151,

Search for items that conflict in the SYLK file created in step 2, and then correct the conflicts.

E Apply the SYLK file again.

Batch Settings

Make batch settings for multiple devices by importing a SYLK (*.slk) file.

See the following for details on creating a SYLK file.
£ “Creating a SYLK file to describe the settings” on page 135

Note:
When you select Show Batch Settings button in Options - Customize Ribbon, the Batch Settings button is
displayed on the Device screen ribbon menu.

£ “Operation Settings” on page 23

Assigning information automatically

Select Devices on the side bar task menu.
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Select the device you want to configure from the device list.

Note:

To make multiple selections, press Ctrl or Shift and click your mouse.

B Epson Device Admin - O x
Home View Groups > @
Q Q. I::] ) ] ®O Add Undo g O

" “ L=2=4 ~v " * ) Delete Re -
All Selected = Auto-Update Batch Apply Configuration tion | Print Status | Discovery Firmware COptions

Devices  Devices Settings Template Sheet(s) -
Update Device Information Configuration Status Sheet Device List Options

4 Default Groups Search Filter [

i All Devices (10) Model |MAC Address IP Address ‘Stalus Last Upds =
= New Devices (0) WF-RE8590 Series ALEESTFRERAF 192.168.0.200 € Error 1/28/201¢
= Configured Devices (1) PX-MT0S0FX 64ERACCAD2:91 192.168.0.52 Idle status 1/28/201t
= Ungrouped E?e‘”‘es ) EP-007F Series AC:18:26:FB:60:7B 192.168.0.55 3 Ink: Follow the m... 1/28/201¢
£ Warning Deviees (2) PX-MBG0F G4ERAC25:41:C5 192,168,054 Idle status 1/28/201t
= Errar DE""?‘ @ WWE-2630 Series AC:18:26:FB:80:43 192.168.0.60 Idle status 1/28/201
= unresponaive Devices () | px-troor AUEESTHAESZIC 192.168.0.57 3 Ink Follow the m..._1/28/2011
“ i User Defined Groups PX_M7050 Series  AGEESTFRELTT 102.168.0.56 T Ink low. (Magent... 1/28/201¢
—
4 Parsoffice @3} PX-ME50F BO:EB92.FFB5:5C 192.168.0.58 Idle status 1/28/201¢
| Sales and Marketing div: -y 7650 Series AAEESTFFT0:81 192.168.0.252 ¥ Inklow. (Cyan)  1/28/201¢
i New York office (0) WE-5690 Series DAEESTFFG2F3 192.168.0.100 Idle status 1/28/201
i London office (0)
4 D]
E Devices
‘ Alerts
g Reports i
BB configurt [«] ] []
niguration Total: 10 - Error: 3 - Warning: 2 - Unresponsive: 0 - Unknown: 0 - Ready: 5 6 / 10

&

Intranet access ‘

Click Batch Settings on the Home tab on the ribbon menu.

Note:

£ “Operation Settings” on page 23

When you select Use batch configuration in Options - Customize Ribbon, the Batch Settings button is displayed on
the Device screen ribbon menu.

View Groups
o G [
Al Selected = Auto-Update
Devices  Devicas

Upe

te Device Information

4 i Default Groups

B All Devices (10)

B New Devices ()

i Configured Devices (0}

@ Ungrouped Devices (5)

3 Warning Devices (2)

i Error Devices (3)

W Unrespansive Devices (0)
4 [ User Defined Groups

4 [ Paris office [2) (5)
i Sales and Marketing div.
W London office (0)

7| [»
FF Devices

‘ Alerts

8 sepors

H configuration

R Intranet access

Epson Device Admin
3] i ®O Add
88 Kead * [ Delete
Batch Apply Configuration Print Status | Discovery
Settings Template Sheet(s)
Configuration Status Sheet
Search Filter Batch Settings
[Model Start batch settings for the ddress |sm’ Last Update
WF-RESO0 Sen  selected devices. L168.0.200 €3 Error 1/28/2016 814
PX-MTO50FX S4EBBC.CAGIO 182.1680.58 Idle status 1/28/2016 814
EP-S07F Series AC:18:26:FB:60:TB 192.168.0.55 €3 Ink: Follow the m... 1/28/2016 &14
PX-MBGOF E4EBBC2541.C5 192.168.0.54 Idle status 1/28/2016 814
WF-2630 Series ACIB:26:FE:B043 192.168.0.60 Idle status 1/28/2016 814
PX-1T00F ALEESTAER2IC 192.168.0.53 €3 Ink: Foliow the m.. 1/28/2016 &14
PX-MT050 Series ALEESTFRELTY 192168062 ¥ ink low. (Magent... 1/28/2016 814
PX-MEB50F BO:EB:92:FF:8%:5C 192.168.0.50 Idle status 1/28/2016 814
WF-T7620 Senes ALEESTFRTOE 182.168.0.252 £ Ink low. (Cyan) 12872006 814
WF-5600 Sevies ALEESTFR62F3 192.168.0.100 B3 idle status 172872016 &14

Totak 10 - Error: 3 - Waming: 2 - Unresponsive: 0 - Unknown: 0 - Ready: 5

Firmware

Options

Optians
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n Click Open.

B (Mo Title) - Batch Settings - O X
File(F) Display(¥) Tools(T) Help(H)
+ + - = ] . - - — :
E Open E Overwrite and Save | WS Display Devices m Display Setting Information ‘0 Refresh #E Transenit
—_

Status Process Status Transmission Result  IP Address Info_ModelMame Info_MACAddress
@Acquire Current ... Assign Successful 192.168.0.55 WP-4330 Series 0026ABAS9S2B
@Acquire Current ... Assign Successful 182,168.0.54 PX-1700F AJEESTAES21C
@Acquire Current ... Assign Successful 192.168.0.53 PX-MT050 Series AJEESTFFE1T

£ >
Press the [F5] key to refresh. 0 selected All 3 items Ready

Select the SYLK file (*.slk) containing the settings, and then click Open.

The settings in the SYLK file are applied to the device.

ﬂ Open File e
T E] » This PC » Documents v O Search Documents ]
Organize + MNew folder = O @
7 Quick access Name Date modified Type
Deskto | AddessBook.slk 8/10/2015 410 AM SLK File
= p »
& Downlosds ~ # | BatchSettings 20130723.slk /22/2015 11:35PM _ SLK File
E] Documents P I|:] BatchSettings_20130810.slk 8/10/2015 3:26 AM SLK File
| Pictures b
J! Music
B videos
f@ OneDrive
[ This PC
=¥ Network
£ >
File name: | BatchSettings_20150810.slk v| [ svikile ¢slio v

E Select the devices for which you want to perform batch settings with the Status column set to Unset, and the
Process Status set to Assign Successful.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.
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[B) BatchSettings_20150810.slk - Batch Settings - O *
File(F] Display(¥) Tools{T) Help(H)
+ + . —_— 5 . : - — :
e Open  po Overwrite and Save E Display Devices E Display Setting Infarmation 0 Refresh #E Transmit
- - —_
Status Process Status Transmission Result  |P Address Info_MeodelMame Info_MACAddress
Unset 68 PX-1700F AAEEST4EB21
@ Unset Assign Successful 192.168.0.55 WP-4530 Series 0026ABASSE2E
. Unset Assign Successful 192.168.0.53 PH-M7050 Series AAEESTFFETTT
£
Display the setting information. 1 selected All 3 iterns Ready
See the following for detailed information on the Batch Settings screen.
£ Epson Device Admin Help "Batch Settings Screen”
7 Click Transmit.
[B) BatchSettings_20150810.slk - Batch Settings - O *
File(F] Display(V] Tools{T) Help(H)
+ + . —_— 5 . : - — -
Po Open | Overwrite and Save =P Display Devices m Display Setting Information 0 Refresh #E Transmit
- - —_
Status Process Status Transmission Result  |P Address Info_MeodelMame Info_MACAddress
Unset Assign Successful 192.168.0.54 PX-1700F AAEEST4ESZ1C
. Unset Assign Successful 192.168.0.55 WP-4530 Series 0026ABASSS2B
. Unset Assign Successful 192.168.0.53 PH-M7050 Series AAEESTFFETTT
£
Transmit the setting information to the selected device. 1 selected All 3 iterns Ready
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E When the password entry screen is displayed, enter the password, and then click OK.

Transmit the settings.

Password *

Device Logon

Enter the cument administrator password.

MAC Address:  A4EESTFFE1T1

Password:

Cancel

Note:
0 A progress meter is displayed while the information is transmitted to the network interface. Do not turn off the
device or the wireless adapter, and do not send any data to the device.

0 See the following to set a password.
£ “Setting an Administrator Password” on page 55

E Click OK.

Transmitting

Device: AMEESYFFE1T1

Status:

/1)

Check the status of the device you set.

For devices that show ) or &g , check the contents of the settings file, and that the device has rebooted
normally.

See the following for detailed information on the Batch Settings screen.
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£ Epson Device Admin Help "Batch Settings Screen”

@ BatchSettings_20150810.slk* - Batch Settings
File(F) Display¥) Tools(T) Help(H)

9P + _— —
E Open E Overwrite and Save E Display Devices m Display Setting Information ‘0 Refresh l’ﬁ Transmit

Status

Process Status

Assign Successful
Assign Successful

<

Transmission Result

IP Address Info_ModelMame
PX-1700F
WP-4330 Series

PX-MT7050 Series

182.168.0.55
182.168.0.53

Info MACAddress
AAEESTAES2TC
0026ABAS982B
AAEESTFFEITT

Press the [F5] key to refresh.

1 selected All 3 items

Ready

Assigning information from settings one at a time (Manually

assigned)

Create a file describing the IP address, subnet mask, and the default gateway, and select one device at a time to make

settings.

Create a file outlining the settings

Open a spreadsheet application (such as Microsoft Excel).

Enter "TCPIP_IPAddressAuto", "TCPIP_IPAddress", "TCPIP_SubnetMask", and "TCPIP_Gateway" in the
first row as the setting item names.

Enter setting items for the following text strings. To distinguish between upper case/lower case and
double-byte/single-byte characters, if only one character is different, the item will not be recognized.

Enter the setting item name as described below; otherwise, Epson Device Admin cannot recognize the setting
items.

TCPIP_IPAddressAuto TCPIP_IPAddress TCPIP_SubnetMask TCPIP_Gateway

Note:

Create a file without MAC address information. Because the MAC address is automatically set as the key for use by
default, information is assigned automatically when a MAC address is found, and manual assignment cannot be
performed. You can change the automatically assigned keys for use in [Tools] - [Options] - [Auto Assign] - [Auto
Assign Key Settings] on the [Batch Settings] screen.
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Enter the values in each row.

"TCPIP_IPAddressAuto" specifies the setting method for assigning the IP address. If the setting value is "5", the
static IP address is manually assigned.

TCPIP_IPAddressAuto

TCPIP_IPAddress

TCPIP_SubnetMask

TCPIP_Gateway

5 192.168.100.102 255.255.255.0 192.168.100.101
5 192.168.100.103 255.255.255.0 192.168.100.101
5 192.168.100.104 255.255.255.0 192.168.100.101

n Enter a name and save as a SYLK file (*.slk).

Reading the configuration file and making settings one at a time

Select [Device] on the side bar task menu.

Select the device you want to configure from the device list.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.

a Epson Device Admin - 0O X
Home View Groups =) 0
Q. 9 G‘) — i ] @O Add ey Undo | Fo

= [=1=] =V " * [ Delete :
All Selected  Auto-Update Batch Apply Configuration Print Status | Discovery Firmware  Options
Devices  Devices Settings Template Sheet(s) -
Update Device Information Configuration Status Sheet Device List Option:
4 [ Default Groups Search Filter
B All Devices (10) Model MAC Address IP Address |Status Last Upda
i New Devices {0} WE-R8590 Series  AAEESTFREIAF 192.168.0.200 9 Error 1/28/201
= Configured Devices (0) PX-MT030FX 64ERBC:CAG291 192.168.0.52 Idle status 17287201t
= Ungrouped Devices 5] EP-907F Series AC18:26:FB:60:TB 192.168.0.55 9 Ink: Follow the m... 1/28/201t
&2 Warning Device: (2) PX-M86OF 64EBBC2541:C5 192.168.0.54 Idle status 1/28/201
B Error Deviess (3) VWF-2630 Series AC:18:26:F8:80:43 192.168.0.60 Idle status 1/28/201t
B Unresponsive Devices [0) [ PX-1700F ALEESTAES21C 192,168.0.57 2 Ink: Follow the m... wzafzou]
.
“ [ User Defined Groups PXMT050 Senes  AGEESTFRETTT 192.168.0.56 T Ik low. (Magent.. 1/28/2011
.
# [ Paris offic= (2] 5] PX-ME30F BO:ES92:FF85:5C 192.166.0.58 Idle status 1/28/201¢
_ mSalesand Marketing div)| e 7600 Series ALEESTFFT0E] 192.168.0.252 U Inklow. (Cyan)  1/28/201(
B New ork office (0) WF-5690 Series ALEESTFF62F3 192.168.0.100 Idle status 17287201t
i London office (0)
1 L3
P Devices
‘ Alerts
é Reporis
- 1 ’
EH configuration Tatal: 10 - Error: 3 - Warning: 2 - Unresponsive: O - Unknown: 0 - Ready: 5 6 / 10
[E\_ Intranet access

Click Batch Settings on the Home tab on the ribbon menu.

Note:

When you select Use batch configuration in Options - Customize Ribbon, the Batch Settings button is displayed on
the Device screen ribbon menu.

£ “Operation Settings” on page 23
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Epson Device Admin -
Groups
[ Add Undo
= P | G B ouni[w] | g
Auto-Update Batch Apply Configuration w Configuration  Print Status | Discovery s | Birmware | Options
| Settings Template Template Sheetfs] h
Update Device Information Configuratian Status Sheet Device List Options
4 @ Default Groups Search Filter Batch Settings |
Al Deviees (1 .
_h Devices (101 Mods Start batch settings for the gees [seatus [tast update
N Dentes 4 WFRESBOSer  selected devices. 1168.0.200 € Enor 1/28/2016 814
i Configured Devices () PX-MTOS0FX B4EBBC.CAS2S1 182.168.058 Idle status 1/28/2016 8:14
in Ungrouped Devices (3} EP-007F Senes ACH8:26FB60:78 1921680555 3 Ink Follow the m,.. 1/28/2016 &:14
.D Warming Devices (2) PX-MBBO0F BAERAC-2541:C5 192.1680.54 Iefle status 1/28/2016 8:14
I8 Error Devices O} WF-2630Seres  ACIG26FBB043 152168060 13 idle status 1/28/2016 814
e mepeae Driwer [ PX-IT00F ALEESTMERZIC 192168053 © i Follow the m... 1/28/2016 814
8 ser Defloed Groupe PX-M7050 Series  AAEESTFEELTI 192.168.0.62 ¥ Ink low. (Magent.. 1/28/72016 814
4 I Poris office Z) (5} PX-MESOF BO:ERO2FFESSC 192.168.0.50 2 e status 1/28/2016 8:14
I Sales and Marketing div. WE-7620 Series ALEESTERT0ET 102.168.0.252 1! Ink low. {Cyan) 1/28/2016 814
M Lordon oftice ) WF-5690 Series ALEESTFRE2FI 192.168.0.100 Ide status 1282016 8:14
i D
¥ Devices
A pens
g Reports
) [l v |
EH configuration Tetal: 10 - Error: 3 - Warmning: 2 - Unresponsive: 0 - Unkmown: 0 - Ready: 5 6 / 10
i ¥
rﬁ Intranet access
Click Open.
[ (No Title) - Batch Settings - O x
File(F) Display(l] Tools(T) Help(H)
T + . —_ - 5 - - - — :
r.—, Open E Overwrite and Save =P Display Devices m Display Setting Information G Refresh #E Transmit
-
Status Process Status Transmission Result P Address Info_ModelMName Info_MACAddress
@Acquire Current ... Assign Successful 192.168.0.55 WP-4530 Series 0026ABAZ982B
@Acquire Current ... Assign Successful 192.168.0.54 PX-1700F AAEESTAEB21C
@Acquire Current ... Assign Successful 192.168.0.53 PX-M7050 Series AAEESTFFETTT
< >
Press the [F5] key to refresh. 0 selected All 3 iterns Ready
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Select the SYLK file (*.slk) containing the settings, and then click Open.

B open File *
T » This PC » Documents v | O Search Documents »
Organize » Mew folder =~ [ @
# Quick access Name Date modified Type
I Desktop + ] AddessBookslk 8/10/2015 410 AM  SLK File
3§ Downloads [ [ BatchSettings_20130723.5lk 1/22/201511:25PM  SLK File
Documents * | ] BatchSettings_20150810.slk 8/10/2015 4:54 AM SLK File
&= Pictures »*
Epson
J‘! Music
B videos
‘@ OneDrive
[ This PC
|_ﬂ Metwork < >
File name: | BatchSettings_20130723.slk v| SYLK file (*.slk) ~
E Click Display Devices, and then select the device you want to set.
Note:
To make multiple selections, press Ctrl or Shift and click your mouse.
[B) BatchSettings_20130723.slk - Batch Settings — O *
File(F] Display(¥) Tools(T) Help(H)
+ + . . . - - - — :
P— Open p— Overwrite and Save || W=l Display Devices BB Display Setting Information G Refresh B Transmit
- - —_
Status Process Status Transmission Result P Address Info_ ModelMame Info MACAddress
. Unassigned Assign Failed 192.168.0.54 P-1700F AAEESTAES21C
@ Unassigned Assign Failed 192.168.0.55 WP-4530 Series 0026ABAS9E2B
. Unassigned Assign Failed 192.168.0.33 PH-MT050 Series AAEESTFFETT
<
Press the [F3] key to refresh. 0 selected All 3 itemns Ready
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B BatchSettings_20130723.slk - Batch Settings

File(F) Display(\c’) Help(H)

fOen"
A

Transmit(T)
Display Details(D)...

Devices m Display Setting Information

- O X

0 Refresh #E Transmit

Status in Result  IP Address Info_MeodelMame Info_MACAddress
Auto Assign(A)
. Unassigned = 192.168.0.54 PX-1700F AAEEST4ES21C
@ Unassigned l [ (e 192,168.0.55 WP-4530 Series 0026ABA8982B
@ Unassigned Release Assign(R) 192.168.0.53 PX-M7050 Series AAEESTFFETT
Options(0]...
<
Assign the setting informatien manually to the selected device. 1 selected All 3 iterns Ready

Note:

If you discover a device when the file is open or after opening the file, auto assignment is performed. If the target
setting information has already been assigned to other devices, setting information is not displayed on the Manually
assign setting information screen. Release the assignments from Tools - Release Assign.

E Select the setting information line you want to assign, and then click OK.

Manually assign setting information. *
Selecting MAC address fordevice: A4EEST4ES21C
[[] Create new setting information from the selected device.
Statye Process Statuc Transmoizsion Reeylt 1P Addrece Info.
nassignes - Eries
. Unassigned WF-5690 Series
£ >
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E Check that Unset is displayed in the Status column and Assign Successful is displayed in the Process Status
column.

(@ Batchsettings_20130723.5lk - Batch Settings - m} x
File(E) Display(y) Toels(T) Help(H)

1 + _ X —

P— Open p— Overwrite and Save =P Display Devices E Display Setting Information ‘0 Refresh #E Transmit

- -~ —_

Status Process Status Transmission Result P Address Info ModelName Info MACAddress
@ Unassigned Assign Failed 192.168.0.55 WP-4530 Series 0026ABAES82B
.Uﬂassigned Assign Failed 182.168.0.53 PX-MT050 Series AAEESTFRETT

< >
Press the [F3] key to refresh. 1 selected All 3 items Ready

Click Transmit, and then click OK.

Creating a SYLK file to describe the settings

You can create a SYLK file to describe information for performing batch settings. You can create a SYLK file using one
of the following methods.

Creating a SYLK file by acquiring information from the connected device

Select Devices on the side bar task menu.

Select the device you want to configure from the device list.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.
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H Epson Device Admin - 0O X
Home View Groups =) 0
Q. 9 _ @o Madd e Undo | |
s 9= L} = d S IR
Al Selected  Auto-Update Batch Em Apply Configuration Print Status  Discovery Firmware ~ Options
Devices  Devices Co Settings Template Sheet(s) -
Update Device Information Configuration Status Sheet Device List Options
< (@ Default Groups Search Filter |
i Al Devices (10) Model |MAC Address IP Address [status Last Upda ~
= Mew Devices (0) WF-RBS90 Series  A4EESTFRESAF 192.168.0.200  Error 1/28/201¢
i Configured Devices (0} PX-MT050FX 64ERAC:CAD2:91 192.168.0.52 Idle status 1/28/201¢
= Ungrouped Devices (3) EP-907F Series AC:18:26:FB:60:78 192.168.0.55 ) Ink: Follow the m... 1/28/201¢
B9 Warning Devices (2) PX-M860F G4ERAC:25:41:C5 192,168,054 Idle status 1/28/201¢
B Error Devices (3) MWE_2A20 Sarias AC12.96-ER.8NA2 107 168 0 AN ™ idla ctabe 177059004
B Unresponsive Devices (0) PX-1700F A4EESTAES2NC 102.168.0.57 9 Inke: Follow the m... 1/28/201¢ l
=
« = '“jE’D_Eﬁ“E"G“’“PS PX-MT030 Series  AEESTHFETT] 792.168.0.56 T Ink low. (Magent.. 1/28/201¢
“ [ Paris office (2] (5] PX-MES0F BO.ES:02:FF25:5C 192.162.0.58 Idle status 1/28/201¢
| Sales and Marketing div) |y 765 Series AGEESTFFT0E] 192,168.0.252 ! Inklow. (Cyan)  1/28/201¢
B New ork office (0) WF-5600 Series ALEESTIFRG2F3 192.168.0.100 Idle status 1/28/201¢
W London office (0)
< L]
E Devices
‘ Alerts
e Reports -
EA configurati d ! [+]
nnguration Total: 10 - Error: 3 - Warning: 2 - Unresponsive: 0 - Unknown: 0 - Ready: 5 6 / 10
-PEI. Intranet access ‘

3

Click Batch Settings on the Home tab on the ribbon menu.

Note:

£ “Operation Settings” on page 23

When you select Use batch configuration in Options - Customize Ribbon, the Batch Settings button is displayed on
the Device screen ribbon menu.

View Groups
@ c)
= =
Aan Selected Auto-Update
Devices  Devices

Update Device Informabon

4 G Default Groups

i All Devices (10)

i New Devices (0)

i Configured Devices (0)

i Ungrouped Devices (5)

2 Wamning Devices (2)

i Error Devices [3)

i Unresponsive Devices (0]
4 [ User Defined Groups

4 [ Paris office {2) (5)
i Sales and Marketing div.
i London office (0

<

¥ Devices

A serts

g Reports
EH configuration

‘h Intranet access

Epson Device Admin

L)

Lod=]

Batrk Apply

Settings
Configuration
Search Filter BatchSettings

e Start batch settings for the
WF-R8580 Ser,  selected devices.
PX-MTO50FX G4EBBC-CA02D1
EP-907F Senes. AC1B26FB60:TE
PX-MESOF B4EBBC2541C5
'WF-2630 Series AC8:26:FB:B0:43
PX-1700F ALEESTAEBLIC
PX-MT030 Series ALEESTFRELTY
PX-MESOF BO:-EBS2FF.E5:5C
WF-T620 Series A4EES <7081
WF-5650 Series ALEESTFFE2:F3

[l

Total: 10 - Error: 3 - Waming: 2 - Unresponsive: D - Unknown: 0 - Ready: 5

Configuration

Template

ddress

L168.0.200
182.168.0.58
192.168.0.55
192.168.0.54
192.168.0.60
192.1680.53
192.168.0.62
192.168.0.50
192.168.0.252
152,168.0.100

= e
@
Add Undo i
P | % 0 K
Frint Status Discovery gt Firmware  Options
Sheet(s) -
Sintus Sheet Devace List Options
[status Last Update =
) Error /2872016 8:14
5 idle status 1/28/2016 8:14
@ Ink: Follow the m... 1/28/2016 8:14
3 Idle status 1/28/2016 8:14
1 idle status 1/28/2016 B:14

3 Ink: Follow the r.. 1/28/2016 8:14
¥ Ink low. (Magent.. 1/28/2016 B:14
B3 1dle status 1/28/2016 8:14

¥ Ink low. (Cyan) 1/28/2016 8:14
Idie status 1/28/2016 8:14
»
6 / 10
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| B (Mo Title) - Batch Settings

— [m| *
l File(F) lDispIay(‘u’] Tools(T)  Help(H)
el ices m Display Setting Information G Refresh #E
Close(C)
esult  IP Address Info_ModelMName Info_MACAddress
QOverwrite and Save(S) X
192.168.0.53 WP-4330 Series 0026ABABSE2B
Save As(A).. 192.168.0.53 PX-MT050 Series AEESTFFETT!
Save Template File(T) 192.168.0.54 PX-1700F AAEESTAES21C
Save transmission result of configurations(E)
Quit(X)
< >
Save the current file with a different file name. 0 selected All 3 items Ready
Enter the file name and select the target folder, and then click Save.
A backup file (*.slk) containing the current settings for all devices is created.
B save as. x
T |‘:_f] » This PC » Documents v O Search Documents 2
Organize = MNew folder SEEE o
# Quick access &3 Mame Date modified Type
[ Desktop » [7] AddessBook.slk 8/10/20154:10 AM  SLK File
& Downloads  #
|£:-‘] Documents  #
&=/ Pictures ~
J‘! Music
B Videos
f@ OneDrive
[ ThisPC
. _ v < >
File name: | BatchSettings_20150810] )
Save as type: | SYLK file (*.slk] ~
= Hide Folders Cancel

E Open the saved SYLK file in a spreadsheet application (such as Microsoft Excel) or in a text editor.

Setting information is entered in each row. Each row contains the settings for each individual device.
Explanations for the setting items is provided on the following page.
£ “Setting items for the SYLK file” on page 144

@ e e ra =

1 2 3

4 5 ] 7 g
Info_ModelMame  Info_MACAddess  Info_CommonDevic Info_Commonlocat Info_SerialMumber TCPIP_IPAddressAL TCPIP_IPTwpe_APIFTCPIP_IPAddress
WP-4530 Series  0026ABAE5828 NXL4000267 : : 10122494
PX-1700F AAEESTAER21C ANULL i i 10122525
PX-M7050 Series  A4EESTFFEI 71 1BE3000046 1 1 1921680151
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You can change settings or add a new row and enter setting information for a new device, and then save the

file.

1 2 & 4 5 ] 7 g
1 Info_ModelMame  Info_MAGAddress  Info_CommonDevic Info_Commonlocat Info_SerialMumber ’TCF‘IP_IF‘AddeBAL"I'CF‘IF‘_IF‘T\/:E_AF‘IFTCF‘IF‘_IF‘AddeB
2 WP-4530 Series  0026ABAE9828 Hing NXL4000267 ’1 ’1 10122494
3 | PX-1700F AAEESTAER21C ANULL i i 10122525
4 | PX-M7050 Series AJEESTFFE! 71 Hino 1BE3000046 1 1 1921680151
5
i
Note:

Security items, such as passwords, or read-only items are not output. When making a batch change to the
Administrator Password, add an "AdminNewPassword" column to the SYLK file, and then enter the new password.
Also, if you want to automatically authorize the new password (without having to enter a password confirmation),
add a column called "AdminCurrentPassword".

Creating a SYLK file based on a template

This section explains how to create a SYLK file based on a TCP/IP template.

Select Devices on the side bar task menu.

Select the device you want to configure from the device list.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.

ﬂ Epson Device Admin = 0 x
Home View Groups & e
% & O & B G O nee ) g

= = a8 o " * [ Delete :
All Selected | Auto-Update Batch Apply Configuration Print Status | Discovery Firmware ~ Options
Devices  Devices Settings Template Sheet(s) M
Update Device Information Configuration Status Sheet Device List Options
< [ Default Groups Search Filter
B All Devices (10) Madel MAC Address IP Address |Status Last Upda
= New Devices (0) WF-RE590 Series  A4ELSTIFFEIAR 192.168.0200 €9 Error 1/28/201¢
i Configured Devices (0) PX-MTOSOFX GAEBBC:CAG2:91 192.168.052 Idle status 1/28/201t
i Ungrouped Devices (3) EP-G07F Series ACH8:26:FB:60:TR 192,168,055  Ink Follow the m... 1/28/201¢
B9 Warning Devices (2) PX-M850F GAERBC:25:41:C5 192.168.054 Idle status 1/28/201¢
B Error Devices (3) WE_JAN Sariac AC-10.0A-FRAN-A2 102 1480 AN ¥ iAl= ctatie 12859014
i Unresponsive Devices [0) I PX-1700F ALEESTAER21C 192.168.0.57 €3 Ink: Follow the m... 1;23/201(]
—
4 v User Defined Groups PX-M7050 Series AAEESTFRELI 192.168.0.56 T Ink low. (Magent... 1/28/201¢
s
4 O Paris office (2) (3) PX-MBS0F BO:ES:92-FF85:5C 192.168.0.58 Idle status 1/28/201¢
= Sales "’”d_ Marketing div, WF-7620 Series ALEESTFRT0B1 192.1680252 U Ink low. (Cyan)  1/28/201¢
i New York office (0) WF-5690 Series PAEESTFFG2F3 192.162.0.100 Idle status 1/28/201¢
i London office (0)
1 »
E Devices
‘ Alerts
é Reports
- 1 '
m oG Total: 10 - Error: 3 - Waming: 2 - Unresponsive: 0 - Unknown: 0 - Ready: 5 6 /10
1 Intranet access
[
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3 Click Batch Settings on the Home tab on the ribbon menu.

Note:
When you select Use batch configuration in Options - Customize Ribbon, the Batch Settings button is displayed on
the Device screen ribbon menu.
<« 3 . »
£ “Operation Settings” on page 23
& Epson Device Admin - 0 %
View Groups =@
7 S - 5 2] T [
= = G =] E3 B o
Aan Selected Auto-Update Batch Apply Configuration Finmware . Options
Devices  Devices figg: Sattings Template -
Update Device Information o Options
4 @ Default Groups Search Filter Batch Settings
_i Al Deriec3 (32} tdode Start batch settings for the Aaes |Su:lus lastpents
T N B £ 0% WF-RES90Ser  selected devices. £1680.200 3 Error 1/28/2016 8:14
i Configured Devices (0) PA-MTOS0FX S4EBBCCAO2OT 192168058 3 e status 1282016 8:14
i Ungrouped et £P-007F Series ACB26FB60:7E 192.1680555 © Ik Follow the m... 1/28/2016 8:14
& Waming Devices (2) PX-MESOF BAERBC2541CS 192168.0.54 2 idie status /282016 814
i Error Devices () WF-2630 Series AC:18.2658:00:43 192.168.0.60 3 idle status 1/28/2016 B:14
B Unrespensive Devices 10) PX-1700F AEESTAES2IC 192168053 ©) Ink: Foliow the m... 1/28/2016 814
4 T User Defined C‘f°”p’ PX-M7050 Series ALEESTFFELT] 192.168.0.62 ¥ Ink low, (Magent... 1/28/2016 814
4 B Paris office 2} {5) PX-MESOF 192.1680.50 e status 1/26/2016 B:14
i Sales and Marketig div. | \wp 7620 Series ' : 192.168.0.252 U inklow. (Cyan)  1/28/2016 814
M Lclon afics (0) WE-560 Series MEESTFRE2F3 192,168.0.100 Idie status 1282016 8:14
) v
5P Devices
A derts
a Reports
] 4| »
m Cohauiatice) Total: 10 - Error: 3 - Waming: 2 - Unresponsive: D - Unknown: 0 - Ready: 5 6 7 10
‘!‘ Intranet access
Click File - Save Template File - TCP/IP settings.
[B (Mo Title) - Batch Settings — m} X
File(F) IDispIayM Tools(T)  Help(H)
el lvics m Display Setting Information Q Refresh #E Transrnit
Close(C)
esult  IP Address Info_ModelName Info_MACAddress
Overwrite and Save(S) )
192.168.0.55 WP-4530 Series DD26ABAR9E28
Rl 192.168.0.53 PX-MTDSD Series ALEESTFFEIT]
Save Template File(T) > All settings 'X-1700F AAEESTAEE21C
Save transmission result of configurations(E) TCP/IP settings
Quit() Default Settings
—
< >
Save settings as a template, 0 selected All 3 items Ready
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Enter the file name and select the target folder, and then click Save.

A SYLK file (*.slk) containing the TCP/IP related items written is created.

E Save As...

T 5 » ThisPC » Documents v O Search Documents 2

Organize « Mew folder == 0

s Quick access & Mame Date modified Type
I Desktop | | AddessBook.slk /10,
‘ Downloads

| Documents

5410 AM SLK File

&=/ Pictures
J’! Music
m Videos

f@ OneDrive

& ThisPC

v £

File name:| BatchSettings 2015081

Save as type: | SYLK file (*.slk)

“ Hide Folders Cancel

E Open the saved SYLK file in a spreadsheet application (such as Microsoft Excel) or in a text editor.
Enter the MAC address and values such as IP address, subnet mask, and default gateway for each row.

See the following for details on each setting item.
£5° “Setting items for the SYLK file” on page 144

1 2 3 4 5 i 7 g
1 Info_ModelMame Info_MACAddress  Info_CommonDevic Info_Commonlocat Info_SerialMumber TCPIP IPAddressALTCRIP IPType APIFTCPIP IPAddress
2 WP-4530 Series 0026 ABABS82B Hino NXL4000267 i i 10122494

1 1

3 | PX-1700F ALEEET4ER21C ANULLY 1 1 10122525
4 | PX-M7050 Series AJEESTFFEIT1 Hing 1BE2000046 i i 1821680151
5
]

Note:
If you do not want to set a value, enter "#NULL#".

Save the file.

Creating a new SYLK file

Using the MAC address and model name as the keys, you can create a new SYLK file to set the IP address.

Open a spreadsheet application (such as Microsoft Excel).
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Enter "Info_ MACAddress", "Info_ModelName", and "TCPIP_IPAddress" in the first row as the setting item
names.

Enter setting items for the following text strings. To distinguish between upper case/lower case and
double-byte/single-byte characters, if only one character is different, the item will not be recognized.

Enter the setting item name as described below; otherwise, Epson Device Admin cannot recognize the setting
items.

Info_MACAddress Info_ModelName TCPIP_IPAddress

Enter the MAC address, model name, and IP address for each network interface.

Info_MACAddress Info_ModelName TCPIP_IPAddress
0000XXXX0001 ALC-XXXXX 192.168.100.102
0000XXXX0002 ALC-XXXXX 192.168.100.103
0000XXXX0003 ALC-XXXXX 192.168.100.104

Enter a name and save as a SYLK file (*.slk).

Backing up device settings

You can backup device settings by using the batch setting function.

Output a device setting value as a SYLK file.

Note:
When you select Use batch configuration in Options - Customize Ribbon, the Batch Settings button is displayed on
the Device screen ribbon menu.

£5° “Operation Settings” on page 23

Select Devices on the side bar task menu.

Select the device you want to backup from the device list.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.
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B Epson Device Admin - B x

Home Wiew Groups @ e

2y 2 ndo
= N= C) é-% (R ] ®O, Bad Ao (g o

B3 Delete Redo

Al Selected | Auto-Update vi Batch Em =d Web | Apply Configuration | Save as Configuration | Print Status | Discovery Firmware Options
Devices  Devices Configuration  Settings Template Template Sheet(s) -
Update Device Information Configuration Status Sheet Device List Options
4 T Default Groups Search Filter \
B All Devices (10) Model |Mac Address IP Address [status Last Upds ~
B New Devices (0) WF-RB500 Series  A4EESTFRESAF 192.168.0.200 9 Eror 1/28/201(
i Configured Devices (0) PX-M7050FX BAEB:BC:CA92:91 192.168.0.52 Idle status 1/28/201¢
i Ungrouped Devices (5] EP-907F Series AC:18:26:FB:60:7B 192.168.055 €3 Ink: Follow the m... 1/28/2011
£ Warning Devices (2) PX-M860F 64ERAC:25:41:C5 192,168,054 Idle status 1/28/201¢
B Error Devices (3) WWE- RN Sariac AC-18.7R-FR-AN-42 102 1620 AN 2 Idls ctatioc 17879011
B Unresponsive Devices (0] PX-1700F A4EESTAES2NC 102.168.057 €3 Ink: Follow the m... 1/28/201¢ ]
4 [ User Defined Groups PX-M7050 Series AAEESTIFETT] T92.168.0.56 T Ik low. (Magent.. 1728/2011
“ o Paris office (2 3) PX-MESOF BO:EB.92FFB5:5C 192.168.058 Idle status 17287201t
B Sales and Marketing divl| e 7650 Series A4EESTFFT0E1 192.168.0252 ! lnklow. (Cyan)  1/28/201¢
B New York office (0) WF-5690 Series ALEESTFRE2F3 192.168.0.100 Idle status 1/28/201¢
i London office (D)
[ R
=7 Devices
‘ Alerts
-
g Reports -
[« ]

E Calicanty Total: 10 - Error: 3 - Wamning: 2 - Unresponsive: 0 - Unknown: 0 - Ready: 5 6 / 10

R Intranet access |

3 Click Batch Setting on the Home tab on the ribbon menu.

B Epson Device Admin =R
View Groups « @
L o) <] Gy o ndo | (g,
= = o & ® e e
An Selected | Auto-Update Baick l:mbedded W Apply Configuration Save as Configuration  Print Status | Discovery Firmware  Options
Devices  Devices figura Settings erve Template Template Sheet(s) -
Update Device Informabon Configuration St Sheet Dewvice List Optiens
4 G Default Groups Search Filter BatchSettings
_- o Detiee3 110} | tdode Seart batch settings for the Aaes |&‘M st pata
B N e WFRESDD Seri  selected devices. 11680200 @ Error 11282016 814
I Configured Devices (0) PX-MTOS0FX BAEBBCCAG2D1 192.168.0.56 15 bdle status 172872016 8:14
i Ungrouped Devices {5) £P-007F Series ACB26FB60:7E 192.168055 © Ik Follow the m... 1/28/2016 8:14
& Waming Devices (2) PX-ME6OF B4ERBC25:41CS 192168054 3 e status 1/28/2016 814
8 Erroe Devicer ) WE-2630Series  ACB26FBA043 192168060 5 ke status 1/28/2016 &:14
M- Unresponanve Drvces () PX-1700F ALEESTAER21C 192168053 © Ink: Follow the m... 1/28/2016 8:14
4 T User °_°""'°° Groups PX-M7050 Series ALEESTFFELT] 192.168.0.62 ¥ Ink low, (Magent... 1/28/2016 814
4 B Paris office 2} {5) P-MB50F BOEBO2FFE5:SC 192.168.0.50 2 1dle status 1/26/2016 B:14
i Sales and Marketing div. WF-7620 Series STFFRT081 192.168.0252  inklow. (Cyan)  1/28/2016 814
I Loedon affice (0 WF-5690 Series 192.168.0.100 Idie status 12812016 814
| v
¥ Devices
‘ Alerts
g Reports -
§ [4] ] vl
B configuration Total: 10 - Error 3 - Warning: 2 - Unrespansive: 0 - Unknawn: 0 - Ready: 5 5/ 10
ng e Ready:

rh Intranet access
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Note:

Select the devices for which you do not want to create a backup file, and then click Tools - Release Assign. Click Yes
when the confirmation message is displayed, and the Status column changes to Unassigned.

B (No Title) - Batch Settings — m] bd
File(F) D\splay(V]HE\p(H)
,-'i Open ':i Transmit(T} Devices [ Display Setting Information | 47} Refresh SR Transmit
| W piplay Details(D)...
Status InResult P Address Info_ModelName Info_MAC Address
g Auto Assign(A) -
192.168.0.55 WP-4530 Series 0026ABAB982B
(® Acquire Current ,—td20uzl Assian(M).. 192.168.0.53 PX-M7050 Series AEESTFFEIT!
(® Acquire Current , Release Assign(R) 192,168,054 PX-1700F AMEESTAES21C
Optiens(0)...
< >
Release the assignment to the selected device. 1 selected All 3 items Ready
. .
Click File - Save as.
@ (Mo Title)" - Batch Settings — m] x
File(F) | Display(¥) Tools(T) Help(H)
Open(Q)... ices B Display Setting Information | 4TV Refresh i Transrric
Close(C)
esult 1P Address Info_ModelName Infio_MACAddress
Overwrite and Save(S) —-
192.168.0.55 WP-4530 Series 0026ABAB9B2B
SRS 192,162,053 PX-MT050 Series AAEESTFFETT!
Save Template File(T) > 192.168.0.54 PX-1700F AEESTAER21C
Save transmission result of configurations()
Quit(x)
< >
Save the current file with a different file name. 1 selected All 3 items Ready
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Enter the file name and select the target folder, and then click Save.

A backup file (*.slk) containing the selected device settings is created.

@ Save As...

Organize «

3 Quick access
I Desktop
{ Downloads
|| Documents
&=/ Pictures
J’! Music

B videos

f@ OneDrive

[ This PC

“ Hide Folders

I = » ThisPC » Documents v | O

Mew folder == @

*

Search Documents y-l

MName Date moedified Type

| | AddessBook.slk 8/10/2015 4:10 AM SLK File

L 4 >

File name: [Batchsmings_zmsomq -

Save as type: | SYLK file (*.slk) ~

Cancel

Save

Setting items for the SYLK file

This section explains the main settings that can be set in the SYLK file.

Item

Description

Info_SerialNumber

Displays the serial number of a device.
This value is acquired from the device. The device is not affected by changing the
value.

Info_MACAddress

Displays the MAC address of a device.
This value is acquired from the device. The device is not affected by changing the
value.

Info_ModelName

Displays the model name of a device.
This value is acquired from the device. The device is not affected by changing the
value.

Info_Software.X.Category (X:1 to 50)

Displays information on the device’s software.
This value is acquired from the device. The device is not affected by changing the
value.

Info_Software.X.Name (X:1 to 50)

Displays information on the device’s software.
This value is acquired from the device. The device is not affected by changing the
value.

Info_Software.X.Version (X:1 to 50)

Displays information on the device’s software.
This value is acquired from the device. The device is not affected by changing the
value.

Info_Software.X.Vendor (X:1 to 50)

Displays information on the device's software.
This value is acquired from the device. The device is not affected by changing the
value.
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Info_CommonDevice

Enter a device name to use as a common protocol.
Enter between 2 and 15 characters using A-Z, a-z, 0-9, and hyphens (-). You can only
use letters for the first character. You cannot use a hyphen for the final character.

You cannot use the following operations and values.
[ Automatically acquiring DNS host name

1 Exceeding 251 characters for the host name or the domain name.

Info_CommonLocation

Enterinformation to identify the device. Forexample, where the device is located. The
number of characters you can enter varies depending on the product.

TCPIP_IPAddressAuto

Specify whether the IP address is set manually or automatically.

1: Auto
5: Manual

TCPIP_IPType_BOOTP

Specify whether you want to set the IP address automatically with BOOTP.
When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: OFF.
1:ON

0: OFF

TCPIP_IPType_RARP

Specify whether you want to set the IP address automatically with RARP.
When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: OFF.
1:ON

0: OFF

TCPIP_IPType_APIPA

Specify whether you want to set the IP address automatically with APIPA.
When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: OFF.
1:ON

0: OFF

TCPIP_IPType_PING

Specify whether you want to set the IP address automatically with PING.
When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: OFF.
1:ON

0: OFF

TCPIP_IPAddress

Specify the IP address in IPv4 format.

You cannot use the following addresses.
0.0.0.0

255.255.255.255

127.0.0.1

224.0.0.0 to 239.255.255.255

TCPIP_SubnetMask

Specify the subnet mask in IPv4 format.

You cannot use the following addresses.
0.0.0.0
255.255.255.255

TCPIP_Gateway

Specify the default gateway in IPv4 format.

You cannot use the following addresses.
255.255.255.255
224.0.0.0 to 239.255.255.255

TCPIP_DNS_AddressAuto

Specify whether you want to obtain the DNS server address manually or
automatically.

When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: Manual.
0: Manual
1: Auto
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TCPIP_DNS_Server.1 to
TCPIP_DNS_Server.N

Specify 1 to N as the number of DNS server addresses that can be registered to the
device in IPv4 format.

You cannot use the following addresses.
255.255.255.255
0.0.0.0

TCPIP_DNS_HostDomainAuto

Specify whether you want to obtain the DNS host name and domain name manually
or automatically.
When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: Manual.

0: Manual
1: Auto

TCPIP_DNS_HostAuto

Specify whether you want to obtain the DNS host name and domain name manually
or automatically.
When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: Manual.

0: Manual
1: Auto

TCPIP_DNS_DomainAuto

Specify whether you want to obtain the DNS host name manually or automatically.
When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: Manual.

0: Manual
1: Auto

TCPIP_DNS_HostName

Enter a DNS host name.

Enter between 2 and 63 characters using A-Z, a-z,0-9, hyphens (-),and dots (.). You can
only use letters for the first character. You cannot use a hyphen or a dot for the final
character.

This valueisinvalid if the total number of characters of the host name and the domain
name exceeds 251.

TCPIP_DNS_DomainName

Enter a DNS name.

Enter between 2 and 249 characters using A-Z, a-z, 0-9, hyphens (-), and dots (.). You
canonlyuselettersforthefirst character. You cannotuse a hyphenoradotfor thefinal
character.

You cannot use the following values.
[ Using more than one dot in a row (for example ..)

1 Exceeding 251 characters for the host name or the domain name.

TCPIP_DNS_DNSRegist

Specify whetheryou wanttoregister the networkinterface address forthe DNS server.

0: Do not register
1: Register

TCPIP_DNS_DirectRegist

Specify how to register the network interface address to the DNS server.

0: Relay the DHCP
1: Register directly

TCPIP_EnableBonjour

Specify whether to use Bonjour.

0: Disable
1: Enable

TCPIP_BonjourName

Specify the Bonjour name.
Enter between 2 and 53 characters using A-Z, a-z, 0-9, and hyphens (-). You can only
use letters for the first character. You cannot use a hyphen for the final character.

TCPIP_BonjourPrinterName

Specify the Bonjour service or Bonjour printer name.
Enter between 1 and 41 characters using A-Z a-z 0-9 I"#5$%8&'()*+,-./;<=>?@[\A_*{|}~
and space.
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EnableMSNet

Specify whether to use Microsoft network shared printing.

0: Disable
1: Enable

MSNet_HostName

Specify the host name of an MS Network.
Enter between 1 and 15 characters using A-Z a-z 0-9 #$@%&;'()-.A_{}~ and space.

MSNet_WorkGroupName

Specify the Workgroup name of an MS Network or domain name.
Enter between 1 and 15 characters using A-Z a-z 0-9 1#$@%&;'()-.A_{}~ and space.

EnableAppleTalk

Specify whether to use AppleTalk.

0: Disable
1: Enable

NetlF_EnableTimeServer

Specify whether to use the time server.

0: Do not use
1: Use

NetlF_TimeServer

Specify the address of the time server.
The format you can enter varies depending on the server.

NetlF_TimeServerinterval

Specify the interval for updating the time server information in seconds.
Enter a value between 1 and 1440 in integral numbers.

NetlF_TimeServerStatus

Displays the communication status of the time server.
This value is acquired from the device. The device is not affected by changing the
value.

USB_HostIF Specify whether to use the USB host I/F.
3:0n
4: Off

USB_IF Specify whether to use the USB I/F.

3:0n
4: Off

Admin_UserName

Specify the administrator name for the device.
Enter an administrator name between 1 and 255 characters except for ASCII control
code.

Admin_PanelLock

Specify whether to enable panel operations.

3:Enable
4: Disable

AdminCurrentPassword

Enter the current password when you want to change the administrator password
using automatic authentication.

AdminNewPassword

Specify an administrator password of the device.

Enter between 1 and 20 characters using A-Z a-z 0-9 I"#$%&'()*+,-./{|}~ and space.
When an administrator password is set for device, you need to enter the current
password.

NICResetCmd

Reset device settings to their defaults.

True: Reset device settings to factory defaults

Note:

Available items vary depending on the device. #NULL# is entered for setting items that are not supported.
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Copyright and Trademarks

4

EPSON is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a
trademark of Seiko Epson Corporation.

Microsoft, Windows, and Windows Vista are registered trademarks of Microsoft Corporation.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of
their respective owners. Epson disclaims any and all rights in those marks.

© Seiko Epson Corporation 2016. All rights reserved.

Notices

L O o U

Reproduction of information in this manual is prohibited.
All information in this manual is subject to change without notice.
If you find inaccuracies or have concerns about this manual, contact Epson.

Notwithstanding the preceding article, Epson cannot be held responsible for any effects resulting from the use of
the product.

Epson cannot be held responsible for any failures caused by the improper use of the product and the improper
repair of the product by a third party.

148



	About this Manual
	Marks and Symbols
	Artwork
	Operating System References

	Contents
	Epson Device Admin Features
	Main Features
	Configuring the System
	Languages

	Setting Up
	System Requirements
	Hardware
	Minimum system requirements
	Recommended system requirements

	Software
	Recommended Software
	Ports to use
	Windows services
	Virtual environment

	Notes on operation

	Installing and Configuring the Environment
	Preparing to install
	.Net Framework
	Epson Device USB Agent

	Installing for the first time and changing features
	Initial installation
	Changing features and uninstalling
	Updating

	Starting up and closing Epson Device Admin
	System settings


	Operation Screen
	Top Screen
	Summary of Each Main Screen
	Side bar task menus
	Device management
	Alert management
	Report management
	Configuration template management


	Installation Settings
	Operation Settings
	Options screen
	Mail
	Timing
	Formats
	Startup
	Customize Ribbon
	Check for updates

	Registering to the device list
	Discovering devices
	Discovering by using the discovery button
	Discovery condition settings

	Specifying individual devices

	Updating Device Information
	Group Management
	Create and edit user-defined groups
	Create an automatic assignment group
	Add a device by creating a group

	Group editing
	Deleting a group


	Device Management
	Device Settings
	Settings Template
	Creating a configuration template
	Creating from the configuration template management screen
	Creating from the device management screen

	Applying configuration template
	Select devices and apply
	Select configuration templates and apply

	Editing configuration templates
	Exporting and importing configuration templates

	Setting or changing devices one at a time
	Device properties screen
	Using an embeded web server to make device settings

	Setting an Administrator Password
	Setting individually
	Managing passwords in batches
	Managing passwords automatically
	Setting a master password
	Editing an administrator password using the list


	Registering Different Address Books
	Editing individually
	Making batch settings
	Creating a settings file
	Reading the settings file


	Updating Device Firmware
	Updating firmware
	Firmware Update Schedule
	Creating a Firmware Update Schedule
	Editing firmware update schedules
	Checking the Status of Firmware Update Schedules



	Daily Management
	Managing the Device List
	Collecting information regularly
	Schedule settings
	Starting Auto Update

	Displaying the device list settings
	Display presets
	Editing columns
	Using filters


	Managing Alerts
	Creating alerts
	Adding groups monitored by alerts
	Setting the alert confirmation interval
	Editing alerts
	Switching the alert display
	Alert list
	Log


	Report Management
	Creating reports
	Configuration Examples for Report Creation

	Acquiring data
	Setting the data collection time and saving period
	Setting the data collection time
	Setting the data saving period

	Switching the report display
	Collecting data
	User defined reports

	Sending archived reports by email
	Saving and deleting archived reports


	Maintenance
	Printing a Status Sheet
	Backing up and Restoring
	Items that can be backed up and restored
	System settings
	Backing up system settings
	Restoring system settings

	Device list
	Saving a device information file
	Reading a device information file

	Password settings
	Backing up passwords
	Restoring passwords

	Address books
	Exporting by setting a password
	Importing files containing security information

	Configuration templates
	Saving configuration templates
	Reading configuration templates



	Troubleshooting
	Troubleshooting
	Cannot discover devices.
	Cannot change the network interface, or cannot use it on the network.
	You do not know the IP address.
	The message "The network connection is invalid or not set. Check the network settings." is displayed ...
	Not Ready is displayed as the IP address on the device list.
	IP address changes on its own.
	Devices from other companies are not displayed in the device list, or they are displayed but not eno ...


	Appendix
	Secondary Device Management Method
	Assigning IP address
	Checking for overlapping items

	Batch Settings
	Assigning information automatically
	Assigning information from settings one at a time (Manually assigned)
	Create a file outlining the settings
	Reading the configuration file and making settings one at a time

	Creating a SYLK file to describe the settings
	Creating a SYLK file by acquiring information from the connected device
	Creating a SYLK file based on a template
	Creating a new SYLK file

	Backing up device settings
	Setting items for the SYLK file

	Copyright and Trademarks
	Notices


